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1 Introduction 

1.1 About absolute encoders 

With an absolute encoder each angular position is assigned a 
coded position value generated by a code disc equipped with 
several parallel fine graduations tracks which are scanned individ-
ually. On single turn encoders, i.e. an encoder producing absolute 
positions within one revolution, the absolute position information 
repeats itself with every revolution. So called multi turn encoders 
can also distinguish between revolutions. The numbers of unique 
revolutions is determined by the resolution of the multi turn scan-
ning and repeats itself after the total resolution is reached. A ma-
jor benefit of absolute encoder type is that if the encoder loses 
power, the encoder is able to keep track of its position also if the 
shaft is turned during the power loss. This is due to the genuine 
absolute scanning principle.  
 
An absolute encoder can also be used to calculate a digital speed 
value. By internally dividing the difference in position with a small 
delta time an accurate speed value can be calculated and trans-
mitted to the subsequent electronics for closed loop control. 
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1.2 About PROFINET technology 

PROFINET is the open industrial Ethernet standard of PROFIBUS 
& PROFINET International (PI) for automation. PROFINET uses 
TCP/IP and IT standards, and is in effect, real-time Ethernet. The 
PROFINET concept features a modular structure so that users can 
select the cascading functions themselves. They differ essentially 
because of the type of data exchange to fulfill the partly very high 
requirements of speed. 
 
In conjunction with PROFINET, the two perspectives PROFINET 
CBA and PROFINET IO exist. PROFINET CBA is suitable for the 
component-based communication via TCP/IP and the real-time 
communication for real-time requirements in modular systems 
engineering. Both communication options can be used in parallel. 
 
PROFINET IO was developed for real time (RT) and isochronous 
real time (IRT) communication with the de-centralized periphery. 
The designations RT and IRT merely describe the real-time prop-
erties for the communication within PROFINET IO. 
 
To achieve these functions, three different protocol levels are de-
fined: 
• TCP/IP for PROFINET CBA and the commissioning of a plant 

with reaction times in the range of 100ms  
• RT (Real-Time) protocol for PROFINET CBA and PROFINET IO 

applications up to 1 ms cycle times  
• IRT (Isochronous Real-Time) for PROFINET IO applications in 

drive systems with cycles times of less than 1ms  
 
Interfacing the peripherals devices such as encoders is imple-
mented by PROFINET IO. Its basis is a cascading real-time con-
cept. PROFINET IO defines the entire data exchange between 
controllers (devices with "master functionality") and the devices 
(devices with "slave functionality"), as well as parameter setting 
and diagnosis.  
 
PROFINET IO is designed for the fast data exchange between 
Ethernet-based field devices and follows the provider-consumer 
model. The configuration of an IO-System has been kept nearly 
identical to the "look and feel" of PROFIBUS.  
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A PROFINET IO system consists of the following devices: 
• The IO Controller, which contains the automation program and 

controls the automation task. 
• The IO Device, which is a field device such as an encoder, mon-

itored and controlled by an IO Controller.  
• The IO Supervisor is software typically based on a PC for set-

ting parameters and diagnosing individual IO Devices.  
 
An application relation (AR) is established between an IO Control-
ler and an IO Device. These ARs are used to define communica-
tion relations (CR) with different characteristics for the transfer of 
parameters, cyclic exchange of data and handling of alarms. 

 
The characteristics of an IO Device are described by the device 
manufacturer in a General Station Description (GSD) file. The lan-
guage used for this purpose is the GSDML (GSD Markup Lan-
guage) - an XML based language. The GSD file provides the su-
pervision software with a basis for planning the configuration of a 
PROFINET IO system. 

 
Within PROFINET IO, process data and alarms are always trans-
mitted in real time (RT). Real time in PROFINET is based on the 
definition of IEEE and IEC, which allow for only a limited time for 
execution of real-time services within a bus cycle. The RT com-
munication represents the basis for the data exchange for 
PROFINET IO and real-time data are always treated with a higher 
priority than TCP (UDP)/IP data.  
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1.3 Encoder Profiles 

Profiles are pre-defined configurations of the functions and fea-
tures available from PROFINET for use in specific devices or appli-
cations such as encoders. They are specified by PI (PROFIBUS & 
PROFINET International) working groups and published by PI. Pro-
files are important for openness, interoperability and interchange-
ability, so that the end user can be sure that similar equipments 
from different vendors perform in a standardized way. 
HEIDENHAIN comply with the definitions in the encoder profile 
3.162, version 4.1. The encoder device profile describing encoder 
functionality and additional information about PROFINET can be 
ordered from PROFIBUS User Organization, PNO. 
 
PROFINET is generally defined by PROFIBUS & PROFINET Inter-
national (PI) and backed by the INTERBUS Club and, since 2003, 
is part of the IEC 61158 and IEC 61784 standards. 
 
PROFIBUS User Organization 
Haid-und-Nue Straβe 7 
D 76131 Karlsruhe 
Tel: +49 721 96 58 590 
Fax: + 49 721 96 58 589 
Web: www.profibus.com 
 

http://www.profibus.com/
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1.5 Abbreviations 

PI  PROFIBUS and PROFINET International 
IO  Input/Output 
DO   Drive Object 
DU  Drive Unit 
AR  Application Relation 
CR   Communication Relation 
MLS  Master Sign-Of-Life 
RT   Real Time Ethernet 
IRT   Isochronous Real Time Ethernet 
IsoM  Isochronous Mode 
LLDP Link Layer Discovery Protocol 
GSD General Station Description 
GSDML General Station Description Markup Language 
UDP User Datagram Protocol 
TCP  Transmission Control Protocol 
IP  Internet Protocol 
DHCP Dynamic Host Configuration Protocol 
TFTP Trivial File Transfer Protocol 
MAC Media Access Control 
I&M  Identification & Maintenance 
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2 Installation 

A summary of the PROFINET guideline: PROFINET Cabling and 
interconnection Technology 
V 1.99, PROFIBUS International, Order No 2.252 is provided in this 
section. 
 

2.1 Cables and standards 

Two shielded copper cables twisted in pairs are defined as the 
normal transmission medium for PROFINET networks. In such 
networks the signal transmission is performed in accordance with 
100BASE-TX at a transmission speed of 100 Mbps (Fast-
Ethernet). 
 
Only shielded cables and connecting elements are allowed in a 
PROFINET network. The individual components have to satisfy 
the requirements of Category 5 in accordance with IEC 11801. The 
entire transmission path has to meet the requirements of Class D 
in accordance with IEC 11801. Furthermore, PROFINET cables 
shall have a cable cross-section of AWG 22 in order to enable 
even complex cabling structures through minimum damping. For 
this reason, the specification of the PROFINET cables supports a 
modular setup, which ensures an IEC 11801-compliant structure 
on adherence to simple installation rules.  
 
Transmission channels lengths are determined by the type of ca-
ble being used. The choice of cable is to be such that a transmis-
sion channel length of 100 meter is achieved between two active 
network devices. The use of a high number of plug connections 
has a negative effect on attenuation and reflection and conse-
quently reduces the transmission channel length.  A maximum of 
three interconnections can be inserted between two active de-
vices without reduction of the permissible transmission lengths of 
100 meters. 
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2.2 Connectors and pin configuration 

M12 connectors are used for connecting the bus lines to the en-
coder. The M12 connector used is a 4-pin female shielded  
D-coded version. 
 
The correct arrangement of the bus connectors are specified as 
follows: 
 
 

 Signal Function Pin 

Tx+ Transmission data +  1 

Tx- Transmission data - 3 

Rx+ Receiver data + 2 

Rx- Receiver data - 4 

Table 1 Bus Connection 

Figure 1  
Bus connectors 

 
Note: The encoder provides integrated switch functionality 

between the two M12 connectors used for PROFINET 
communication. It is important to distinguish between 
these ports when IRT-communication is used.  

 
The M12 connector used for power supply of the encoder is con-
stituted by a 4-pin male shielded A-coded version. 
The correct arrangement of the power supply line is specified as 
follows: 
 
 
 

 Signal Function Pin 

+E Volt Power supply 1 

Not connected - 2 

0 Volt 0 Volt 3 

Not connected - 4 

Table 2 Power supply connection  

Figure 2  
Power supply connector 
 
Note: Passive T-couplings are not possible to use in a 

PROFINET network. All devices must be connected 
through active network components. 

 Port 2 

 Port 1 

 Supply 
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2.3 Shielding concept of the encoder 

Automation systems in an industrial environment are subjected to 
high levels of electromagnetic disturbance. Switching large elec-
trical loads creates high interference levels that can be picked up 
in various ways by electronic devices with detrimental effects. 
Even under such conditions, electric components within an auto-
mation system must still guarantee a continuous, uninterrupted 
function.  
 
The electromagnetic compatibility (EMC) of the entire plant must 
be ensured by using suitably designed components and assem-
bling them correctly to make up the system. Data cabling is con-
sidered as a passive system and cannot be tested for EMC com-
pliance individually. Nevertheless, cabling and connection ele-
ments for PROFINET supports compliance with devices require-
ments by providing a high-quality, comprehensive shielding con-
cept.  
 
To achieve the highest possible noise immunity and resistance 
against other EMC related disturbances the bus and power supply 
cables shall always be shielded. The screen should be connected 
to ground on both ends of the cable. In certain cases compensa-
tion current might flow over the screen. 
 

2.4 MAC-address 

PROFINET IO field devices are addressed using MAC addresses 
and IP addresses. All field devices have a unique MAC address. 
The MAC address is constituted by a 6 byte Ethernet address for 
each individual station and is unique worldwide. The MAC address 
consists of two parts, the first 3 bytes represents the manufac-
turer-specific ID and the last 3 bytes represents a consecutive 
number. The MAC address of the encoder is printed on the en-
coder label for commissioning purposes.  
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2.5 LED indication 

The following table defines diagnostic indications shown by the 
encoders two bi-colored LEDs. 
 

Bus Module Meaning Cause 

Off Off No power  

Red Green No connection to anoth-
er device. 
Criteria: No data ex-
change 

- bus disconnected 
- Master not availble/ 

switched off 

Blinking* red Green Parameterization fault, 
no data exchange 
Criteria: Data exchange 
correct, however the en-
coder did not switch to 
the data exchange mode 

- Slave not configured 
yet or wrong configu-
ration 

- Wrong station address 
assigned 

- Actual configuration of 
the slave differs from 
the nominal configura-
tion 

Green Red System failure Diagnosis exists, slave in 
data exchange mode 

Green Green Data exchange and en-
coder functions properly 

 

Blinking* green Blinking green Firmware upgrade in 
process 

 

Blinking* red Blinking red Failure during firmware 
upgrade 

 

*) The blinking frequency is 0.5 Hz. Minimal indication time is 3 seconds. 

Table 3 Led indication 
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3 Configuration example 

This chapter will illustrate how to setup and configure a 
PROFINET encoder for working in RT Class 1 mode. In the follow-
ing examples SIMOTION SCOUT V.4.1.5.6 and D435 motion con-
troller is used. Please refer to the manufacturer of the configura-
tion tool if other configuration tools are being used. 
 

3.1 Device description file installation (GSDML) 

In order to start using an absolute encoder with PROFINET inter-
face, a device description file needs to be downloaded and im-
ported to the configuration software. The device description file is 
called a Generic Station Description Markup Language file and 
contains the necessary implementation parameters needed for a 
PROFINET IO device. 
 
The GSDML file can be downloaded from www.heidenhain.com 

 

GSDML file 

GSDML-V2.2-JH-PROFINET-Encoder-xxxxxxxx.xml 

Table 4 GSDML file 
 
 

http://www.heidenhain.com/
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Installation of GSDML-files 
 
 

Figure 3 Installation of GSDML file 
 
1. Select Options -> Install GSD File and click the Browse button 

to navigate to the location of the GSD file. If a bitmap picture 
representing the encoder is requested, make sure that the 
bitmap file is located in the same folder as the GSDML file. A 
bitmap file is included in the zip-file downloadable from 
www.heidenhain.com. 

 
2. Select the GSD file and click the Installbutton to start installing 

the selected GSD file.  
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3.2 Setting encoder configuration 

 
When the GSD file has been installed the supported encoder 
types can be found in the HW Configuration under PROFINET IO-
>Additional Field Devices->Encoders->JH Group PROFINET En-
coders. Select either multi turn 25 bit or single turn 13 bit encoder, 
dependent on the type of encoder to be configured. Drag and 
drop the encoder onto the PROFINET IO system as shown in the 
picture below. In the example below one 25 bit multiturn encoder 
was chosen. If more than one encoder shall be configured, then 
the following steps need to be done once for each device. 
 

 

Figure 4 Encoder configuration 
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When correctly done, the encoder will appear on the PROFINET 
IO system as shown in figure 5 below. 
 
 

Figure 5 Example of connected encoder 
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The next step will be to choose the data length and the type of 
data that should be sent to and from the IO controller. This is done 
by choosing different telegrams. Available telegrams for the multi- 
turn 25 bit encoder can be found under Multiturn 25 Bit -> EO 
Multiturn. In the example below standard telegram 81 is used. 
Drag and drop the telegram onto slot 1, sub slot 2 as shown in 
the figure 6 below. For more information regarding the different 
telegrams refer to chapter 4.4. 
 

 

Figure 6 Telegram selection 
 
The Standard Telegram 81 will appear on slot 1 sub slot 2  
according to figure 7 below. 
 

 

Figure 7 Selected telegram 
 
Note: The steps above need to be performed once for each 

device. 
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3.3 Setting encoder device name 

In a PROFINET network all IO devices needs to have a unique de-
vice name. The encoders are delivered without any device name 
preset from the factory. To set the encoder device name, double 
click on the encoder icon to open the Properties window. 
 
 

Figure 8 How to set encoder device name 
 
 
In the Properties window, enter an appropriate device name in the 
Device name field. 
 
 

Figure 9 Device name 
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Make sure that the checkbox Assign IP address via IO controller is 
checked if the IP address for the encoder should be assign via the 
IO controller. 
 
Then select PLC-> Ethernet->Assign Device Name to open the 
Assign device name window. 
 
 

Figure 10  Assign device name 
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Choose the device on which the device name should be changed 
and then click on the Assign name button to adopt the changes 
and then click on the Close button. The MAC address of the en-
coder is written on the encoder label. 
 
 

Figure 11  Assign name 
 
Note: All connected devices need to be assigned a unique 

device name. 
 

After changing device name, it is recommended to verify that the 
performed change has been done. This is done by opening the 
Verify Device Name window found under PLC->Ethernet->Verify 
Device Name. 
 
 

Figure 12  How to verify device name 
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In the Verify Device Name window, verify that the Device name 
has changed and the status is OK as shown in the example ac-
cording to figure 13 below. 
 
 

Figure 13  Verify device name  
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3.4 Setting encoder parameters 

This chapter describes how to change the user parameters in the 
encoder. 
 
To set the encoder user parameters double click on the Parameter 
Access point field located under slot 1.1 as shown in figure 14, to 
open the Properties window. 

 
 

Figure 14  Parameter Access point 
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In the Properties window, choose the Parameters" tab. To set the 
parameter data, change the value of the different parameters by 
clicking on the drop down list in the Value field for the respective 
parameter. For more information regarding parameter data, see 
chapter 7. 
 
 

Figure 15  Parameter data 
 
 
When the configuration and parameterization of the device has 
been done, the settings need to be saved and compiled. This is 
done by clicking on the Save and Compile option under the Sta-
tion tab.  
 
 

Figure 16 Save and compile 
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Then the settings need to be downloaded to the IO-controller. This 
is done by clicking on the Download option under the PLC Tab. 

 
 

Figure 17  Download settings 
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3.5 Isochronous real time settings (RT Class 3) 

This example is intended to illustrate the commissioning of a 
PROFINET encoder in isochronous operation. In the example be-
low STEP 7 v5.4 SP5 and SIMOTION D435 motion controller is 
used. The basic principal for configuration and parameterization of 
the encoder is the same as described in chapter 3.2-3.4.  
 
To set the IRT settings of the encoder, double click on the Inter-
face field located under slot 0, sub slot X1 to open the Properties 
window. 
 

 

Figure 18  Open Interface properties 
 
 
Under the Synchronization tab change the value for the Parameter 
RT Class to IRT and the IRT option parameter to High Perfor-
mance according to the picture below. 
 

 

Figure 19 RT Class option 
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Under the Application tab check the box for Operate IO de-
vice/application in isochronous mode. 
 

 

Figure 20 Interface properties 
 
Under the IO Cycle tab change the Update Time Mode to fixed 
factor. 
 

 

Figure 21 IO Cycle properties 
  



Configuration example 

33 

Before the encoder can operate in IRT mode it is necessary to set 
from which port of the encoder the connection to the network 
has been done.  
 
To set the topology double click on the port from which the en-
coder is connected to the network. This is either slot 0 sub slot P1 
or slot 0 sub slot P2. In the example in figure 22 below Port 1 is 
used on the encoder. For port description of the encoder see 
chapter 2.2 Connectors and pin configuration. 

 
 

Figure 22 Port settings 
 
Under the Topology tab change the Partner port to the used port 
of your IO controller. 
 

 

Figure 23 Topology settings 
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When the above steps have been performed, it is recommended 
to verify that the setting for the encoder and the IO controller is 
correct. This is done by opening the Domain management Win-
dow found under Edit->PROFINET IO. 
 
Verify that the RT Class is set to IRT and that the IRT option is set 
to High performance. 
 
 

Figure 24 Domain management 
 
The encoder is now prepared for operating in IRT mode. 
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4 PROFINET IO data description 

4.1 Encoder profile overview, PNO order no.3.162 

This manual is related to encoders that fulfills the demands and 
functionality according to encoder profile V4.1 (PNO no 3.162). 
The operating functions for encoders according to this profile are 
divided into two application classes, named Class 3 and Class 4. 
For an overview of the different encoder profile for PROFIBUS 
and PROFINET and the related standards, see figure 25 below. 

 
For further information regarding the encoder functionality refer to 
the device profile. The profile and PROFINET technical information 
can be ordered at PNO in Karlsruhe, Germany 
(www.profinet.com). 
 
 
 

Figure 25 Overview of encoder profiles 

 
  

http://www.profinet.com/
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4.2 Application Class definition 

The PROFINET encoders can be configured as a class 3 or class 4 
PROFINET IO device according to the encoder profile V.4.1 (PNO 
no 3.162). A Class 4 configured encoder fully supports all func-
tionality according to the encoder profile V4.1. 
 

CLASS 3 Encoder with base mode parameter access and limited parame-
terization of the encoder functionality. Isochronous mode is not 
supported.  
  

CLASS 4 Encoder with scaling, Preset and base mode parameter access. 
Isochronous mode is supported. 
 

4.3 Standard signals 

Table 5 below describes the standard signals that are used to con-
figure the IO data. The signals are described in the chapters that 
follow. 
 

Significance Abbreviation Length  
(bits) 

Data type 

Velocity value A NIST_A 16 Signed 

Velocity value B NIST_B 32 Signed 

Control word G1_STW 16 Unsigned 

Status word G1_ZSW 16 Unsigned 

Position value 1 G1_XIST1 32 Unsigned 

Position value 2 G1_XIST2 32 Unsigned 

Position value 3 G1_XIST3 64 Unsigned 

Control word 2 STW2_ENC 16 Unsigned 

Status word 2 ZSW2_ENC 16 Unsigned 

Table 5  Standard signals 
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4.4 Standard telegrams 

Configuration of PROFINET encoders are made by choosing dif-
ferent telegram structures. The telegrams are used to specify the 
data length and which type of data that are sent to and from the 
IO controller. The following standard telegrams are supported. 

 
4.4.1  Standard Telegram 81 

Standard telegram 81 uses 4 bytes for output data from the IO 
controller to the encoder and 12 bytes of input data from the en-
coder to the IO-controller.  

 
Output data from the IO controller: 
2 bytes Control word 2 (STW2_ENC). 
2 bytes Control word (G1_STW). 

 

IO Data (word) 1 2 

Byte 0 1 2 3 

Set point STW2_ENC G1_STW 

Table 6 Output data Telegram 81 
 
Input data to the IO controller: 
2 bytes Status word 2(ZSW2_ENC). 
2 bytes Status word (G1_ZSW). 
4 bytes Position value 1 (G1_XIST1). 
4 bytes Position value 2 (G1_XIST2). 

 

IO Data (word) 1 2 3 4 5 6 

Byte 0 1 2 3 4 5 6 7 8 9 10 11 

Actual value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2 

Table 7 Input data Telegram 81 
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4.4.2  Standard Telegram 82 

Standard telegram 82 uses 4 bytes for output data from the IO 
controller to the encoder and 14 bytes of input data from the en-
coder to the controller. 
 
Output data from the IO controller: 
2 bytes Control word 2 (STW2_ENC). 
2 bytes Control word (G1_STW). 
 

IO Data (word) 1 2 

Byte 0 1 2 3 

Set point STW2_EN
 

G1_STW 

Table 8 Output data Telegram 82 
 
Input data to the IO controller: 
2 bytes Status word 2(ZSW2_ENC). 
2 bytes Status word (G1_ZSW). 
4 bytes Position value 1 (G1_XIST1). 
4 bytes Position value 2 (G1_XIST2). 
2 bytes Velocity value A (NIST_A) 
 

IO Data (word) 1 2 3 4 5 6 7 

Byte 0 1 2 3 4 5 6 7 8 9 10 11 12 13 

Actual value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2 NIST_A 

Table 9 Input data Telegram 82 
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4.4.3  Standard Telegram 83 

Standard telegram 83 uses 4 bytes for output data from the con-
troller to the encoder and 16 bytes of input data from the encoder 
to the controller. 
 
Output data from the IO controller: 
2 bytes Control word 2 (STW2_ENC). 
2 bytes Control word (G1_STW). 
 

IO Data (word) 1 2 

Byte 0 1 2 3 

Set point STW2_ENC G1_STW 

Table 10 Output data Telegram 83 
 
Input data to the IO controller: 
2 bytes Status word 2(ZSW2_ENC). 
2 bytes Status word (G1_ZSW). 
4 bytes Position value 1 (G1_XIST1). 
4 bytes Position value 2 (G1_XIST2). 
4 bytes Velocity value B (NIST_B) 

 

IO Data (word) 1 2 3 4 5 6 7 8 

Byte 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

Actual value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2 NIST_B 

Table 11 Input data Telegram 83 
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4.4.4 Standard Telegram 84 

Standard telegram 84 uses 4 bytes for output data from the con-
troller to the encoder and 20 bytes of input data from the encoder 
to the controller. 
 
Output data from the IO controller: 
2 bytes Control word 2 (STW2_ENC). 
2 bytes Control word (G1_STW). 
 

IO Data (word) 1 2 

Byte 0 1 2 3 

Set point STW2_ENC G1_STW 

Table 12 Output data Telegram 84 
  
Input data to the IO controller: 
2 bytes Status word 2(ZSW2_ENC). 
2 bytes Status word (G1_ZSW). 
8 bytes Position value 3 (G1_XIST3). 
4 bytes Position value 2 (G1_XIST2). 
4 bytes Velocity value B (NIST_B) 
 

IO Data 
(word) 

1 2 3 4 5 6 7 8 9 10 

Byte 0 1 2 3 4 5 6 7 8 9 1
0 

1
1 

1
2 

1
3 

1
4 

1
5 

1
6 

1
7 

1
8 

1
9 

Actual 
value 

ZSW2
_ENC 

G1_ZS
W 

G1_XIST3 G1_XIST2 NIST_B 

Table 13 Input data Telegram 84 
 
Note: In standard Telegram 84, G1_XIST2 is used to transfer 

error codes and optionally position values if the meas-
uring length exceeds 64 bits. 
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4.5 Manufacturer telegram 59001 

The manufacturer telegram 59001 is a simplified telegram to get 
cyclic data transmission and also the possibility to do a preset via 
IO-data without the need of control word and status words. 
The preset function can be used to set the actual position of the 
encoder to any entered value within the working range of the en-
coder. If scaling is active and has been done on the encoder it is 
only possible to enter a preset value within the working range of 
the encoder. 
The preset is activated when the most significant bit (bit 31) is set 
to 1. The actual preset value should be entered in the following 
bits according to below. 
 
 

IO Data (word) 1 2 

Byte 0 1 2 3 

Bits 31(MSB) 30-24 23-16 15-8 7-0(LSB) 

 Preset control bit Preset value < total resolution 

Table 14 Output data from IO-controller to encoder 
 
The manufacturer telegram 59001 input data consist of a 4 bytes 
position data value and a 4 byte velocity value as shown below. 
The velocity value uses the format that is defined in the Velocity 
measuring unit. 
 

IO Data (word) 1 2 3 4 

Byte 0(MSB) 1 2 3(LSB) 4(MSB) 5 6 7(LSB) 

Actual value Position value 
32 bit Unsigned in 

Velocity value 
32 bit Signed int 

Table 15 Input data from encoder to IO-controller 
 
 
Note: User parameter Class 4 functionality and G1_XIST1 

Preset control must be activated in order to activate 
the preset in manufacturer telegram 59001. 
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4.6 Format of G1_XIST1 and G1_XIST2 

The G1_XIST1 and G1_XIST2 signals consist of the absolute posi-
tion value in binary format. By default the G1_XIST1 signal is equal 
to the G1_XIST2 signal. The format of the actual position values in 
G1_XIST1 and G1_XIST2 is shown below. 
 
Format definition for G1_XIST1 and G1_XIST2: 
• All values are presented in binary format 
• The shift factor is always zero (right aligned value) for both 

G1_XIST1 and G1_XIST2. 
• The setting in the encoder parameter data affects the position 

value in both G1_XIST1 and G1_XIST2. 
• G1_XIST2 displays the error telegram instead of the position 

value if error occurs. 
 

Example:  
25 bit multi turn absolute encoder (8192 steps per 
revolution, 4096 distinguishable revolutions) 

 
M = Multi turn value (Distinguishable revolutions)  
S = Single turn value (number of steps per revolutions) 

 
 

 
 

 

Figure 26 Absolute value in G1_XIST1 

 
 

 
 
 

 

Figure 27 Absolute value in G1_XIST2 
 

  



PROFINET IO data description 

43 

4.7 Format of G1_XIST3 

G1_XIST3 is a 64 bit position value which is used to support en-
coders with a resolution exceeding 32 bits. 
 
Format definition for G1_XIST3: 
• Binary format 
• The actual position value is always right aligned, a shifting factor 

is not used. 
• The settings in the encoder parameter data affect the position 

value in G1_XIST3 if Class 4 is enabled. 
 

IO Data 1 2 3 4 

Format 64 bit position value 

Table 16 Format of G1_XIST3 
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4.8 Control word 2 (STW2_ENC) 

The control word 2 (STW2_ENC) is referred to as the master sign 
of life and it includes the fault buffer handling and Control by PLC 
mechanism from PROFIdrive STW1 and the Controller Sign-Of-
Life mechanism from PROFIdrive STW2. This signal is mandatory 
for controlling the clock synchronization. 
 

Bit Function 

0..6 Reserved 

7 Fault Acknowledge 

8,9 Reserved 

10 Control by PLC 

11 Reserved 

12..15 Controller Sign-of-life 

Table 17 Control word 2 (STW2_ENC) 
 
 

Bit Value Significance Comments 

7 1 Fault Acknowledge (0->1) The fault signal is acknowledged with 
a positive edge. The encoder reaction 
to a fault depends on the type of fault. 

0 No significance  

10 1 Control by PLC Control via interface, EO IO Data is 
valid.  

0 No Control by PLC EO IO Data not valid,  
except Sign-Of-Life 

12..15  Controller Sign-Of-Life  
 

Table 18 Detailed assignment of control word 2 (STW2_ENC) 
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4.9 Status word 2 (ZSW2_ENC) 

The status word 2 (ZSW2_ENC) is referred to as the slave’s sign 
of life and it includes the fault buffer handling and Control by PLC 
mechanism from PROFIdrive ZSW1 and the Slave Sign-Of-Life 
mechanism from PROFIdrive ZSW2. This signal is mandatory for 
controlling the clock synchronization. 
 

Bit Function 

0..2 Reserved 

3 Fault present/No fault 

4..8 Reserved 

9 Control requested 

10,11 Reserved 

12..15 Encoder Sign-of-life 

Table 19 Status word 2 (ZSW2_ENC) 
 
 

Bit Value Significance Comments 

3 1 Fault Present Unacknowledged faults or currently not 
acknowledged faults (fault messages) are pre-
sent (in the buffer).The fault reaction is fault-
specific and device-specific. The acknowledging 
of a fault may only be successful, if the fault 
cause has disappeared or has been removed 
before. If the fault has been removed the en-
coder returns to operation. The related fault 
numbers are in the fault buffer. 

0 No Fault  

9 1 Control 
requested 

The automation system is requested to as-
sume control. 

0 No Control 
requested 

Control by automation system is not possible, 
only possible at the device or by another inter-
face. 

12..15  Encoder  
Sign-Of-Life 

 
 

Table 20 Detailed assignment of status word 2 (ZSW2_ENC) 
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4.10 Control word (G1_STW) 

The control word controls the functionality of major encoder func-
tions. 
 

Bit Function 

0..7 Function requests: Reference mark search, 
measurement on the fly 

8..10 Reserved (without effect) 

11 Home position mode position mode (Preset) 

12 Request set/shift of home position (Preset) 

13 Request absolute value cyclically 

14 Activate parking sensor 

15 Acknowledging a sensor error 

Table 21 Control word (G1_STW) 
 
Note: If the sensor parking is activated (bit 14 = 1) the encod-

er is still on the bus with the slave sign of life active 
and the encoder error and diagnostics switched off. 
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4.11 Status word (G1_ZSW) 

The status word defines encoder states, acknowledgements, er-
ror messages of major encoder functions. 
 

Bit Function 

0..7 Function status: Reference mark search, measure-
ment on the fly 

8 Probe 1 deflected 

9 Probe 2 deflected position mode (Preset) 

10 Reserved, set to zero 

11 Requirements of error acknowledgment detected 

12 Set/shift of home position (Preset) executed 

13 Transmit absolute value cyclically 

14 Parking sensor active 

15 Sensor error 

Table 22 Status word (G1_ZSW) 
 
Note: If bit 13 Transmit absolute value cyclically or bit 15 Sen-

sor error is not set there is no valid value or error code 
transferred in G1_XIST2. 

 
Note: Bit 13 Transmit absolute value cyclically cannot be set 

at the same time as bit 15 Sensor error as these bits 
are used to indicate either a valid position value 
transmission (bit 13) or the error code transmission  
(bit 15) in G1_XIST2. 
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4.12 Real time communication 

PROFINET IO uses three different communication channels to ex-
change data with programmable controllers and other devices. 
The non real time channel based on for example TCP (UDP)/IP is 
used for parameterization, configuration and acyclic read/write 
operations.  
 
The RT or Real Time channel is used for process data transfer and 
alarms. 
Real-time data are treated with a higher priority than data sent 
over the open channel. RT communications overrides the open 
channel to handle the data exchange with programmable Control-
lers.  
 
The third channel, Isochronous Real Time (IRT) is the high perfor-
mance, high speed channel used for demanding motion Control 
applications. IRT data are treated with a higher priority than RT da-
ta sent over the RT channel. 
 
 

Figure 28 Real time Communication 
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PROFINET distinguishes between three real time classes for 
transmission of time critical process data. The three RT classes 
are: 
 
Real-Time, RT Class 1 
 

• Unsynchronized Real time communication 
• Industrial standard switches can be used. 
• Typical application area: Factory automation 
 
Real-Time, RT Class 2 
 

• Synchronized and unsynchronized data transmission 
• Special switches supporting IRT is needed 
• Typical application area: Factory automation 
 
Isochronous Real Time, RT Class 3 
 

The isochronous operation mode is used when real-time position-
ing with high performance is required. The basic principal is that all 
PROFINET devices on the net are clock synchronized with the 
controller using a global control broadcast enabling simultaneous 
data accusation from all devices with microsecond accuracy. The 
data exchange cycles for IRT are usually in the range of a few 
hundred microseconds up to a few milliseconds. The difference to 
real-time communication is essentially the high degree of deter-
minism, so that the start of a bus cycle is maintained with high 
precision. The synchronization is monitored by sign-of life mes-
sages in Control word 2 (STW2_ENC) and Status word 2 
(ZSW2_ENC). 
 
• Clock synchronized data transmission 
• Special switches supporting IRT is needed 
• IRT is required for example motion control applications 
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5 Alarms and warnings 

5.1 Diagnostics and Alarms 

Diagnostic data is always transferred acyclically using Record Data 
communications over the non real time channel. An IO Supervisor 
must specifically request the diagnostic or status data from the IO 
device using RDO (Record Data Object) services. 
 
Alarm data is transmitted from the IO device to the IO controller 
via the RT channel. 
Alarm is generated by the encoder when failure occurs which ef-
fects the position value. Alarms can be reset (deleted) when all 
encoder parameters are within the specified value ranges and the 
position value is correct. 
 

5.2 Channel diagnostics 

The encoder outputs a diagnostic interrupt to the CPU when it de-
tects one of the supported channel diagnostics. 
 

Supported channel 
diagnostic 

Diagnostic data 
record 

Description 

Position error 0x900A The encoder fails to read the correct 
position value 

Memory error 0x9000 The encoder fails to read stored  
offset or preset values from the  non 
volatile memory 

Commissioning  
diagnostics 

0x9011 User parameter data assignment  
error 

Table 23 Channel diagnostics 
 
In a SIMATIC STEP 7 system the operation system responds by 
calling a diagnostic OB. The OB number and start information pro-
vides the cause and location of the error. The error information can 
be read by calling a system Function block (SFB54 RALRM for 
STEP 7). Then the user can decide how the system should handle 
the error. 
 
Note: If the called OB is not included in the program the CPU 

will go to stop. 
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5.3 Sensor status word 

Diagnosis information can be obtained by monitoring of the Error 
bit in the Sensor Status word G1_ZSW (bit 15) and evaluation of 
the error code transmitted in G1_XIST2. 
 

Supported diagnostic Error code in 
G1_XIST2 

Description 

Sensor group error 0x0001 The encoder fails to read the correct 
position value  

Memory error 0x1001 The encoder fails to read stored offset 
or preset values from the non volatile 
memory 

Command not supported 0x0F01 User parameter data assignment error 
or command error in commands words 
G1_STW and STW2_ENC 

Master´s sign of life fault 0x0F02 The number of permissible failures the 
controller’s life sign was exceeded. 

Table 24 Sensor status word 
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6 Acyclic Parameter Data 

6.1 Acyclic data exchange 

In addition to the cyclic data exchange, the PROFINET encoder al-
so supports acyclic data exchange. The acyclic data exchange is 
transferred over the non-real time channel and is used to read out 
and write status information from and to the IO device. The acyclic 
data exchange is conducted in parallel to the cyclic data commu-
nication.  
 
Example of acyclic data: 
 

• Reading of diagnostic 
• Reading of I&M functions 
• Reading of PROFIdrive parameters 
 
 

6.2 Identification and Maintenance (I&M functions) 

Encoders according to the encoder profile 3.162 also support I&M 
functionality. 
The main purpose of the I&M functions is to support the end user 
if the device is acting faulty or missing some of its functionality. 
The I&M functions could be seen as an electronic nameplate con-
taining common information regarding the device and its manu-
facturer.  
 
According to the PROFINET specification all IO devices must at 
least support the following I&M functions: 
 

• Order ID 
• MAC address 
• Hardware Version 
• Software Version 
• Product type 
• Manufacturer ID 
 
For more information regarding additional I&M functions support-
ed by the encoder, refer to chapter 7.14.6. 
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6.3 Base mode parameter access 

The PROFIdrive parameters and the encoder parameter 65000 
can be accessed by the Acyclic Data Exchange service using the 
Base Mode Parameter access local (Record Data Object 0xB02E). 
 

6.3.1  General characteristics 

Acyclic parameter can be transmitted 1(single) or up to 39 (multi) 
in one access. A parameter access can be up to 240 bytes long. 
 

6.3.2  Parameter requests and responses 

Request header:  
Request ID, DO-ID and number of parameters of the access. 
 
Parameter address:  
One address for each parameter, if several parameters are ac-
cessed. 
 
Parameter value:  
If the Request ID is 0x02 (change value) the value is set in the re-
quest and if the Request ID is 0x01 (request value), the value ap-
pears in the reply. 
 

6.3.3  Changing the preset value 

Table 23 below shows the structure of a change value request. 
 

Write of Preset value, parameter 65000 
 Parameter request 

Request reference 0x00  

Request ID 0x02 0x02 Change value, 0x01read value 

DO-ID (axis) 0x01 Drive Object ID 

No of parameters  0x01  

Attribute 0x10 0x10Value 

No of elements 0x00  

Parameter number 0xFDE8 Parameter 65000 

Sub index 0x0000  

Format 0x04 Data type integer 32 

Number of values 0x01  

Table 25 Changing the preset value 
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6.3.4 Reading the preset value 

The tables below show the structure of a read value request. 
 

Read of Preset value, parameter 65000 
 Parameter request 

Request reference 0x00  

Request ID 0x01 0x01read value 

DO-ID (axis) 0x01 Drive Object ID 

No of parameters  0x01 0x01 Read one parameter 

Attribute 0x10 0x10Value 

No of elements 0x00  

Parameter number 0xFDE8 Parameter 65000 

Sub index 0x0000  

Table 26 Reading the preset value (request) 
 
 

Read of Preset value, parameter 65000 
 Parameter response 

Request reference 0x00 mirrored 

Response ID 0x01 0x01read value 

DO-ID (axis) 0x01 mirrored 

No of parameters  0x01  

Format 0x04 0x04= Data type unsigned 32 

No of values 0x01  

Values or errors 0x00,0x00,0x00,0x64 Preset value 100 

Table 27 Reading the preset value (response) 
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6.4 Supported parameters 

 
6.4.1  Parameter 922, read only 

922 unsigned int, presents which telegram is used. Telegram 81,82,83, 
84 or 59001 is possible. 

 
6.4.2  Parameter 925, read/write 

925 unsigned int, maximum allowed MLS (Master sign-of-life) error. Pa-
rameter 925 may be used to set a maximum on how many consecutive 
Sign-of-life failures may occur. 

 
6.4.3  Parameter 964, read only 

964unsigned int 
 
964[0] = Manufacturer Id. This is set during manufacturing of the encoder. 
964[1] = 0DU Drive unit type, always set to 0. 
964[2] = 201Software version 
964[3] = 2009Software year 
964[4] = 2805 Software day and month 
964[5] = 1 Number of drive objects (DO) 
 

6.4.4  Parameter 965, read only 

965OctetString 2 
 
965[0] =0x3DEncoder profile number 
965[1] = 31 or 41 Encoder profile version, set by customer (us-
er_parameters) 
 

6.4.5  Parameter 971, read/write 

971 unsigned int, Stores the local parameter set to a non volatile 
memory. Preset value is saved when writing value 1 and is set to 0 by the 
encoder firmware when finished. This means that the preset value has 
been saved when reading back value 0.  
 

6.4.6  Parameter 974, read only 

974unsigned int 
 
974[0] = 96Max array length supported by parameter channel. 
974[1] = 1Numbers of multi parameters, 1 = no support of multi pa-
rameters. 
974[2] = 1000max time to process parameter request, n x 10 ms. 
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6.4.7  Parameter 975, read only 

975unsigned int 
 
975[0] = Manufacturer Id, Set in the production. 
975[1] = 7011DO type 
975[2] = 201Software version 
975[3] = 2009Software year 
975[4] = 2805Software day and month 
975[5] = 0x0005 PROFIdrive DO type class 5 = encoder interface 
975[6] = 0x8000 PROFIdrive SUB class 1, Encoder application class 4 sup-
ported.  
975[7] = 0x0001Drive object Id (DO ID). 

 
6.4.8  Parameter 979, read only 

979unsigned long 
 
979[0] = 0x00005111 Number of index describing encoder, Numbers of de-
scribed encoders, Version of parameter structure 
 
979[1] = 0x80000000 Sensor type 
Bit 31 = 1 if configuration and parameterization is OK 
Bit 0 = 0 Rotary encoder, Bit 0 = 1 linear encoder  
Bit 1 = 0 always set to 0 
Bit 2 = 0 32 bit data, Bit 2 = 1 64 bit data 
 
979[2] = 8192  Encoder scaled resolution 
979[3] = 0 Shift factor for G1_XIST1 always set to 0. 
979[4] = 0 Shift factor for G1_XIST2 always set to 0. 
979[5] = 1 or 4096 Singleturn = 1, Multiturn = 4096 
979[6] = 0 
979[7] = 0 
979[8] = 0 
979[9] = 0 
979[10] = 0 
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6.4.9 Parameter 980, read only 

This parameter shows the supported parameters 
 
980unsigned int 
 
980[0] = 922  980[9] = 61001  
980[1] = 925  980[10] = 61002  
980[2] = 964  980[11] = 61003 
980[3] = 965  980[12] = 61004 
980[4] = 971  980[13] = 65000 
980[5] = 974  980[14] = 65001 
980[6] = 975  980[15] = 65002 
980[7] = 979  980[16] = 65003 
980[8] = 61000   980[17] = 0 
 

6.4.10 Parameter 61000, read/write 

Name of station 
61000 OctetString, 240 octets 
 

6.4.11 Parameter 61001, read only 

IP of station 
61001unsigned long 
 

6.4.12 Parameter 61002, read only 

MAC of station 
61002OctetString, 6 octets 
 

6.4.13 Parameter 61003, read only 

Default gateway of station 
61003 unsigned long 
 

6.4.14 Parameter 61004, read only 

Subnet mask of station 
61004 unsigned long 
 

6.4.15 Parameter 65000 read/write 

Used with telegram 81-83. 
65000 signed long, preset value 32 bit. 
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6.4.16 Parameter 65001, read only 

Used with telegram 81-84 and 59001 
65001 unsigned long 
 
65001[0] = 0x000C0101 Header, Version of parameter structure 
and numbers of index describing the encoder. 12 index and ver-
sion 1.01 
 
65001[1] = Operating status (Bit 4 alarm channel control is always 
set with profile version 4.x) 
 
65001[2] = Alarm 
65001[3] = Supported alarms 
65001[4] = Warning 
65001[5] = Warnings supported 
65001[6] = 0x00000401 Encoder profile version. Always set to 
this value. 
 
65001[7] = Operating time 
65001[8] = Offset value 
65001[9] = Singleturn value, scaled value 
65001[10] = Total measuring length, scaled value (Linear = 1) 

 
65001[11] = Velocity unit  
• step/10 ms 
• step/100 ms 
• step/1000 ms 
• RPM 
 

6.4.17 Parameter 65002, read/write 

Used with telegram 84 
65002 signed long long, Preset value 64 bit. 
 

6.4.18 Parameter 65003, read only 

Used with telegram 84 
65003 unsigned long long,  
 
65003[0] = 0x0000000000040101Header Version of parameter 
structure and numbers of index describing encoder. 4 index and 
version 1.01 
65003[1] = Offset value 64 bit 
65003[2] = Singleturn value 64 bit, scaled value 
65003[3] = total measuring range in measuring units 64 bit, 
scaled value (Linear =1) 
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6.5 Example of reading and writing to a parameter 

This is an example of S7 blocks used for reading and writing to pa-
rameter 65000 (preset value). Experience with S7 programming 
and Statement List programming language STL is required. 
 

Hardware components 
   

IO controller SIEMENS S7-F CPU CPU 315F-2PN/DP 

IO Device PROFINET encoder 

Table 28 Hardware components 
 

Software components 

SIMATIC STEP 7 V5.4 + SP5 

GSDML file for 
PROFINET encoder 

GSDML-V2.2-JH-PROFINET- 
Encoder-xxxxxxxx.xml 

Table 29 Software components 
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6.5.1  Used blocs 

Write record block SFB53 WRREC 
Read record block SFB52 RDREC 
Instance data blocks DB3 and DB4 
Request data block DB1 
Response data block DB2 
Organization blocks OB1, OB82 and OB86 
 
SFB52 
SFB52 is standard S7 block for reading parameters. 
 
SFB53 
SFB53 is standard S7 block for writing parameters. 
 
DB1 
DB1 is the request data block. 
 

 

Figure 29 Request data block, DB1 
 
 
DB2 
DB2 is the response data block. 
 

 

Figure 30 Response data block, DB2 
  



Acyclic Parameter Data 

61 

DB3 
DB3 is the instance data block of SFB52 
 

 

Figure 31 Instance data block, DB3 
 
 
DB4 
DB4 is the instance data block of SFB53 

 
 

Figure 32 Instance data block, DB 
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OB1 
OB1 controls the read and write operation. 

 
 

Figure 33 Organization block, OB1 
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Parameters of SFB52 
 

Parameter Declaration Data type Description 

REQ INPUT BOOL REQ=1 Enables data transfer 

ID INPUT DWORD 
Logical address of the PROFINET IO 
module or sub module (PAP-module 
address 2039) 

INDEX* INPUT INT Record number 

MLEN* INPUT INT Maximum length of the record in-
formation in bytes 

VALID OUTPUT BOOL New record has been received and 
is valid. 

BUSY OUTPUT BOOL Busy=1 during the read operation 

ERROR OUTPUT BOOL Error=1 read error 

STATUS OUTPUT DWORD Block status or error code 

LEN* OUTPUT INT Length of record information 

RECORD IN_OUT ANY Target area for the record 

Table 30 Parameters of SFB52 
 

*) Negative values are interpreted as 16-bit unsigned integers. 
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Parameters of SFB53 
 

Parameter Declaration Data type Description 

REQ INPUT BOOL REQ=1 Enables data transfer 

ID INPUT DWORD 
Logical address of the PROFINET IO 
module or sub module (PAP-module 
address 2039) 

INDEX* INPUT INT Record number 

LEN* INPUT INT Length of the record information in 
bytes 

DONE OUTPUT BOOL Data record was transferred 

BUSY OUTPUT BOOL Busy=1 during the write operation 

ERROR OUTPUT BOOL Error=1 write error 

STATUS OUTPUT DWORD Block status or error code 

RECORD IN_OUT ANY Data record 

Table 31 Parameters of SFB53 
 

*) Negative values are interpreted as 16-bit unsigned integers. 
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Diagnostic address of slot 1 
 
 

Figure 34 Diagnostic address of slot 1 
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Variable table 
 
With the variable table the user can monitor and modify variables. 
 
 

Figure 35 Variable table 
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To change the value of parameter 65000 with the variable table perform the following 
steps: 

 
1) Enable monitoring by clicking the Monitor variable button. 
2) Write 02hex to address DB1.DBB 1 by entering B#16#02 in the modify value 

column. 
3) Write the new preset value in hexadecimal to address DB1.DBD 12 by entering 

the value in the modify value column. (Ex.DW#16#000001F4) 
4) Click the Modify variable button. The status value of DB1.DBB 12 should now 

contain the new value. 
5) Run the program-right click on M8.4 and click “Modify address to 1” to run the 

program. Then stop the program by right click and click “Modify address to 0”. 
6) The status value of DB2.DBD 6 should now have been changed to the new 

preset value. 
7) Change the value in DB1.DBB 1 to 01hex (B#16#01#) and click modify variable. 
8) To set the encoder to the new preset value bit 12 in control word must be set to 

1. This is done by writing 1000hex (W#16#1000) to address PQW 2. Then click 
the button Modify variable to make the preset of the encoder. 

9) The encoder can now at any time be set to the preset value by setting bit 12 in 
control word (G1_STW). 
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7 Functional description of the encoder 

This chapter describes the functions that have been implemented 
in PROFINET encoders from HEIDENHAIN. The table below 
shows the supported functions in the PROFINET encoder. 
 

Function 

Code sequence 
 
Class 4 functionality 

G1_XIST1 Preset control 

Scaling function control 

Alarm channel control 

Compatibility mode 

Preset value 

Preset value 64 bit 

Measuring units per revolution/Measuring step 

Total measuring range 

Measuring units per revolution 64 bit 

Total measuring range 64 bit 

Maximum Master Sign of Life failures 

Velocity measuring unit 

Encoder Profile version 

Operating time 

Offset value 

Offset value 64 bit 

Table 32 Supported encoder functions 
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7.1 Code sequence 

 
The code sequence defines whether the absolute position value 
should increase during clockwise or counter clockwise rotation of 
the encoder shaft seen from flange side. The code sequence is by 
default set to increase the absolute position value when the shaft 
is turned clockwise (0). 
 

Attribute Meaning Value 

CW Increasing position values with clockwise 
rotation (seen from shaft side) 

0 

CCW Increasing position values with counter 
clockwise rotation (seen from shaft side) 

1 

Table 33 Code sequence 
 
Note: The position value will be affected when the code se-

quence is changed during operation. It might be nec-
essary to perform a preset after the code sequence has 
been changed. 

 
 

7.2  Class 4 functionality 

This parameter enables or disables the measuring task functions 
Scaling, Preset and Code sequence. If the function is enabled, 
scaling and Code sequence control affects the position value in 
G1_XIST1, G1_XIST2 and G1_XIST3. A preset will in this case al-
ways affect G1_XIST2 and G1_XIST3 but if the parameter 
G1_XIST1 Preset control is disabled the preset will not affect the 
position value in G1_XIST1.  
 

Attribute Meaning Value 

Enable Scaling/preset/code sequence control 
enabled 

1 

Disable Scaling/preset/code sequence control 
disabled 

0 

Table 34 Class 4 functionality 
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7.3 G1_XIST1 Preset control 

This parameter controls the effect of a preset on the G1_XIST1 
actual value. 
If Class 4 functionality is activated and G1_XIST1 Preset control is 
disabled, the position value in G1_XIST1 will not be affected by a 
Preset. 
 

Attribute Meaning Value 

Enable G1_XIST1 is affected by a preset com-
mand 

0 

Disable Preset does not affect G1_XIST1 1 

Table 35 G1_XIST1 Preset control 
 
Note: This parameter is disabled by setting the value to 1. 
 
Note: There is no functionality of this parameter if the Class 4 

functionality parameter is disabled. 
 
 

7.4  Scaling function control 

This parameter enables or disables the Scaling function of the en-
coder. 
 

Attribute Meaning Value 

Enable Scaling function is enabled 1 

Disable Scaling function is disabled 0 

Table 36 Scaling function control 
 
Note: The parameter Class 4 functionality must be enabled 

to use this parameter. 
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7.5  Alarm channel control 

This parameter enables or disables the encoder specific Alarm 
channel transferred as Channel Related Diagnosis. This functionali-
ty is used to limit the amount of data sent in isochronous mode. 
 
If the value is zero (default value) only the communication related 
alarms are sent via the alarm channel. If the value is one (1) also 
encoder profile specific faults and warnings are sent via the alarm 
channel. 
 

Attribute Meaning Value 

 Enable Profile specific diagnosis is switch on 1 

Disable No profile specific diagnosis (default) 0 

Table 37 Alarm channel control 
 
Note: This parameter is only supported in compatibility 

mode. 
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7.6  Compatibility mode 

This parameter defines if the encoder should run in a mode com-
patible to Version 3.1 of the Encoder Profile. See below for an 
overview of functions affected when the compatibility mode is 
enabled. 
 

Attribute Meaning Value 

 Enable Compatibility with encoder Profile V3.1 0 

Disable No backward compatibility (default) 1 

Table 38 Compatibility mode 
 

Function Compatibility mode ena-
bled (=0) 

Compatibility mode  
disabled (=1) 

Control by PLC 
(STW2_ENC) 

Ignored, the control word 
(G1_STW) and the set point 
values are always valid. 
Control requested 
(ZSW2_ENC) is not sup-
ported and is set to 0. 

Supported 

User parameter Maximum 
Master Sign of Life failures 

Supported Not supported, one Sign of 
Life failure tolerated, 
PROFIdrive P925 is optional 
to control the life sign moni-
toring. 

User parameter Alarm 
channel control 

Supported Not supported, the applica-
tion alarm channel is active 
and controlled by a 
PROFIdrive parameter. 

P965 Profile Version 31 (V3.1) 41 (V4.1) 

Table 39 Compatibility mode overview 
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7.7 Preset value 

The preset value function enables adaptation of the position value 
from the encoder to a known mechanical reference point of the 
system. The preset function sets the actual position of the encod-
er to zero (= default value) or to the selected preset value. The 
preset function is controlled by bits in the control word (G1_STW) 
and acknowledged by a bit in the status word (G1_ZSW). A preset 
value can be set more than once and it can be stored to the non-
volatile memory using PROFIdrive parameter 971. 
 
The preset function has an absolute and a relative operating mode 
selectable by bit 11 in the Control word (G1_STW). Bit 11 and bit 
12 in the Control word controls the preset in the following way. 
 
Normal operating mode:  Bit 12 = 0 
In this mode, the encoder will make no change in the output val-
ue. 
 
Preset mode absolute: Bit 11 =0, Bit 12 = 1 
In this mode, the encoder reads the current position value and 
calculates an internal offset value from the preset value and the 
current position value. The position value is then shifted with the 
calculated offset value to get a position value equal to the preset 
value. No preset will be made if a negative preset value is used 
while trying to initiate an absolute preset. 
 
Preset mode relative: Bit 11 =1, Bit 12 = 1 
In this mode the position value is shifted by the preset value, 
which could be a negative or a positive value set by encoder pa-
rameter 65000 or 65002. 
 
The steps below should be followed by the IO-controller when 
modifying the Preset value parameters: 
 
1. Read the requested Preset value parameter and check if the 

returned value meets the application requirements. If not, 
proceed with the following steps. 

2. Write the Preset value into the individual parameter. 
3. Store the value in the non-volatile memory by PROFIdrive pa-

rameter 971 if the value should be valid also after the next 
power on sequence. 

 
Note: The preset function should only be used at encoder 

standstill. 
 
Note: The number of possible preset cycles is unlimited. 
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Note: If scaling is used the preset function shall be used after 
the scaling function to ensure that the preset value is 
entered in the current measuring unit. 

 
Note: There is no preset activated when the preset value is 

written to the encoder. The preset function is controlled 
by bits in the control and status words (G1_STW and 
G1_ZSW) and bit in the operating parameters. The pre-
set value is used when a preset is requested by bit 12 
in the control word (G1_STW). 

 
7.8 Scaling function parameters 

The scaling function converts the encoder’s physical absolute po-
sition value by means of software in order to change the resolu-
tion of the encoder. The scaling parameters will only be activated 
if the parameter Class 4 functionality and Scaling function control 
are enabled. The permissible value range for the scaling is limited 
by the resolution of the encoder. The scaling parameters are se-
curely stored in the IO controller and are reloaded into the encod-
er at each power-up. 
 

7.8.1  Measuring units per revolution 

This parameter sets the single turn resolution of the encoder. In 
other words it is the number of different measuring steps during 
one revolution of the encoder. 
 
Example:  
For a 13-bit encoder with a single turn resolution of 13 bits the 
permissible value range for "Measuring units per revolution" is be-
tween 20 and 213 (8192).  
 

Parameter Meaning Data type 

Measuring units 
per revolution 

The single turn resolution 
in measuring steps 

Unsigned 32 

Measuring units 
per revolution 
64 bit 

The single turn resolution 
in measuring steps for en-
coders with a resolution 
exceeding 32 bits. 

Unsigned 64 

Table 40 Measuring units per revolution 
 
Note: After downloading new scaling parameters, the preset 

function must be used to set the encoder starting 
point to absolute position 0 or to any required starting 
position within the scaled operating range. 



Functional description of the encoder 

75 

7.8.2  Total measuring range 

This parameter sets the total measuring range of the encoder. The 
total measuring range is calculated by multiplying the single turn 
resolution with the number of distinguishable revolutions.  
 
Example:  
The total measuring range for a 25 bit multi turn encoder with a 13 
bit single turn and a 12 bit multi turn resolution is between 20 and 
225 (33 554 432). 
 
The total measuring range is calculated as below: 
 

Measuring units per revolution x Total measuring range 
= 8192 (2

13) x 4096 (212) 
= 33554432 

 
 
If the total measuring range is higher than 31 bit, telegram 84 and 
acyclic encoder parameter 65002 and 65003 must be used. In 
this case the 64 bit values are used and the 32 bit values are set 
to zero (0) by the encoder. 
 
The device has two different operating modes, depending on the 
specified measuring range. When the device receives a parame-
ter message, it checks the scaling parameters if a binary scaling 
can be used. If binary scaling can be used, the device selects op-
erating mode A (see following explanation). If not, operating mode 
B is selected. 
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A. Cyclic operation (binary scaling) 
Cyclic operation is used when operating with 2X number of turns 
(2, 4, 8, 16, 32, 64, 128, 256, 512, 1024, 2048. 4096... number of 
turns). If the desired total measuring range is equal to the speci-
fied single turn resolution * 2X (where x<= 12) the encoder oper-
ates in endless cyclic operation (0 - max - 0 -max). If the position 
value increases above the maximum value by rotating the encod-
er shaft, the encoder continues from 0. 
 
Example of a cyclic scaling: 
Measuring units per revolution  =  1 000 
Total measuring range  = 32 000  
(25 = number of revolutions 32) 
 
 

 

Figure 36 Cyclic operation 
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B. Non-cyclic operation 
If the desired total measuring range is not equal to the specified 
single turn resolution * 2X (where x<= 12) the encoder operates 
in non-cyclic operation. The non-cyclic operation is affected by the 
parameter G1_XIST1 Preset control as described below. 
 
G1_XIST1 Preset control = Enabled 
If the position value increases or decreases outside the maximum 
value or below 0 with the parameter G1_XIST1 Preset control en-
abled, the device outputs the maximum position value within the 
scaled total range for both position values G1_XIST1 and 
G1_XIST2. 
 
Example of non-cyclic scaling with G1_XIST1 Preset control 
enabled: 
Measuring units per revolution  =  100 
Total measuring range  = 5000  
(number of revolutions 50) 
 
 

 

Figure 37 Non cyclic operation, preset control enabled 
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G1_XIST1 Preset control = Disabled 
With the parameter G1_XIST1 disabled, and if the position value 
increases or decreases outside the maximum value or below 0, 
the device will output the maximum position value within the 
scaled total range for the position value G1_XIST2. The position 
value G1_XIST1 is not limited to the scaled total range. For the 
position value G1_XIST1, the device will continue to output a 
scaled position value within the encoder’s total measuring range 
(up to 33554432 positions for a 25 bit encoder). 
 
Example of non-cyclic scaling with G1_XIST1 Preset control 
disabled: 
Measuring units per revolution  =  100 
Total measuring range  = 5000  
(number of revolutions 50) 
 
 

 

Figure 38 Non cyclic operation, preset control disabled 
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Handling 64 bit data 
Siemens hardware configuration tool does not support 64 bit data 
type, so when writing larger numbers than 32 bit into the configu-
ration tool, this needs to be done according to below: 
 
Example:  
Total measuring range in measuring units = 236   
 

 
236= 68719476736 = 0x 00 00 00 10 00 00 00 00 
 
 
  
 
Take the 4 least significant bytes above and convert to decimal: 
0x00 00 00 00 =0 = Total measuring range LSB 
 
Then take the 4 most significant bytes above and convert to 
decimal: 
0x00 00 00 10 =16= Total measuring range MSB  
 

In the configuration software enter the decimal values: 
Total measuring range LSB = 0 
Total measuring range MSB  = 16 
 

 
7.9  Maximum Master Sign-of-Life failures 

With this parameter the number of allowed failures of the mas-
ter´s sign of life is defined. The default value is one (1). 
 

Parameter Meaning Value 

Maximum Master  
Sign-of-Life failures 

The number of permissible 
failures of the masters life 
sign. 

1...255 

Table 41 Maximum master Sign of life failures 
 
Note: This parameter is only supported in compatibility 

mode. 
 

  

MSB  LSB  

4 byte=32 bit 4 byte=32 bit 
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7.10 Velocity measuring units 

This parameter defines the coding of the velocity measuring units 
used to configure the signals NIST_A and NIST_B. Standard tele-
gram 81 has no velocity information included and the encoder 
does not use the velocity unit information in this case. Telegram 
82,83,84 and 59001 includes velocity output and needs a declara-
tion of the velocity measuring unit. 
 

Parameter Meaning Value 

Velocity measuring 
units 

Definition of the units for 
the encoder velocity output 
value 

See below 

Velocity measuring units Value 

Steps/s 0 

Steps/100ms 1 

Steps/10ms 2 

RPM 3 

Table 42 Velocity measuring units 
 

The velocity calculations are made with a maximum of 19 bits 
resolution. If the resolution is higher than 219, the value used for 
velocity calculations is automatically reduced to 219. 
 
Example:  
For a 37 bit multi turn encoder with a 225 single turn resolution 
and a 212 multi turn resolution, the maximum single turn value for 
velocity calculations will be 219. For a single turn encoder the max-
imum resolution can be up to 31 bit, but the value used for veloci-
ty calculations will in this case also be 219. 
 
Note: In case of the steps/s unit, an average is made over 

200 ms and the value is multiplied by 5. 
 
Note: If scaling has been set on the device the velocity calcu-

lation is based on the scaled position value. Conse-
quently the accuracy of the velocity value is dependent 
of the scaling set to the device. 
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7.11 Encoder profile version 

The encoder Profile Version is the version of the encoder profile 
document implemented in the encoder. This parameter is not af-
fected by the Compatibility mode settings. 
 

Bits Meaning 

0..7 Profile Version, least significant number, 
(value range: 0-99), decimal coding 

8..15 Profile Version,most significant number, 
(value range: 0-99), decimal coding 

16..31 Reserved 

Table 43 Encoder profile 
 
 

7.12 Operating time 

The operating time monitor stores the operating time for the de-
vice in operating hours. The operating time is saved every six 
minutes in the non-volatile memory in the device. This happens as 
long as the device is powered on.  
 
If the operating time function is not used the operating time value 
is set to the maximum value (0xFFFF FFFF).  
 

Parameter Meaning Data type 

Operating time The accumulated  
power on time 

Unsigned 32 

Table 44 Operating time 
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7.13 Offset value 

The offset value is calculated in the preset function and shifts the 
position value with the calculated value. The offset value is stored 
in a non volatile memory and can be read from the encoder at any 
time. The data type for the offset value is a 32 bit or 64 bit binary 
value with sign, whereby the offset value range is equal to the 
measuring range of the device.  
 
The preset function is used after the scaling function. This means 
that the offset value is indicated according to the scaled resolution 
of the device.  
 

Parameter Meaning Data type 

Offset value The offset value for encod-
ers with a measuring range 
of maximum 32 bits 

Integer 32 

Offset value 64 bit The offset value for encod-
ers with a measuring range 
exceeding 32 bits 

Integer 64 

Table 45 Offset value 
 
Note: The offset value is read only and cannot be modified 

by a parameter write access. 
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7.14 Acyclic data 

The PROFINET encoder support the following acyclic data ex-
change functions. 
 

7.14.1 PROFIdrive parameters 

The encoder profile V4.1 (PNO no. 3.162) has adopted certain 
standard PROFIdrive parameter. The following PROFIdrive param-
eters are supported: 
 

PNU (Prm.no) Significance Data type Read/Write 

922 Telegram selection Unsigned 16 R 

925 Number of Controller Sign-of-Life 
failures which may be tolerated. 

Unsigned 16 R/W 

964 Device identification Array[n]  
Unsigned 16 

R 

965 Encoder Profile number Octet string 2 R 

971 Transfer to non volatile memory Unsigned 16 W 

974 Base Mode Parameter Access 
service identification 

Array[n]  
Unsigned 16 

R 

975 Encoder object identification Array[n]  
Unsigned 16 

R 

979 Sensor format Array[n]  
Unsigned 32 

R 

980 List of supported parameters Array[n]  
Unsigned 16 

R 

Table 46 Supported PROFIdrive parameters 
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7.14.2 Encoder parameter numbers 

The table below specifies the encoder specific parameter that is 
supported. 
 

PNU (Prm.no) Significance Data type Read/Write 

61000 Name of station Octet String 
[240] 

R 

61001 IP of station Unsigned 32 R 

61002 MAC of station Octet String[6] R 

61003 Default gateway of station Unsigned 32 R 

61004 Subnet Mask Of Station Unsigned 32 R 

65000 Preset value Integer 32 R/W 

65001 Operating status Array [n]  
Integer 32 

R 

65002 Preset value 64 bit Integer 64 R/W 

65003 Operating status 64 bit Array [n]  
Integer 64 

R 

Table 47 Encoder parameter numbers 
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7.14.3 Parameter 65000 and 65002- Preset value 

The parameter 65000 and 65002 sets the value for the preset 
function. The parameter 65002 should be used if the preset value 
exceeds 32 bits. 
 

PNU 65000  

Significance Preset value  

Data type Integer 32 

Access Read and write 

Validity range Profile specific 

Explanation The preset value sets the value for the preset 
function. The preset value can be stored in 
the non volatile memory by PROFIdrive pa-
rameter 971 and will be reloaded at each start 
up if stored. 

Table 48 Parameter 65000, Preset value 
 
 

PNU 65002  

Significance Preset value  

Data type Integer 64 

Access Read and write 

Validity range Profile specific 

Explanation The preset value sets the value for the preset 
function. The preset value can be stored in 
the non volatile memory by PROFIdrive pa-
rameter 971 and will be reloaded at each start 
up if stored. 

Table 49 Parameter 65002, Preset value 64 bit 
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7.14.4 Parameter 65001-Operating status 

This parameter structure is a read only structure where infor-
mation on the Encoder operating status can be found. It is a com-
plement to the PROFIdrive parameter 979 described in the Profile 
for Drive Technology, PROFIdrive V4.1, Order nr 3.172 available 
from PROFIBUS and PROFINET International. 
 

PNU 65001  

Significance Encoder Operating Status 

Data type Array[n] Integer 32 

Access Read 

Validity range Profile specific 

Explanation The operating status displays the status of 
the encoder. 

Table 50 Parameter 65001, Operating status 
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Sub index Meaning  

0 Header 

1 Operating status 

2 Faults 

3 Supported Faults 

4 Warnings 

5 Supported warnings 

6 Encoder Profile version 

7 Operating time 

8 Offset value 

9 Measuring units per revolution 

10 Total measuring range in measuring units 

11 Velocity measuring unit 

Table 51 Parameter 65001, Sub index 
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Sub index 1:  Operating status 
In sub index 1 the status of different encoder functions can be 
read out. The mapping of the respective functions is according to 
the table below. 
 

Bits Definition 

0 Code sequence 

1 Class 4 functionality 

2 G1_XIST1 Preset control 

3 Scaling function  control 

4 Alarm channel control 

5 Compatibility mode 

6...7 Reserved for the Encoder manufacturer 

8..31 Reserved for future use 

Table 52 Parameter 65001, Sub index 1 
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7.14.5 Parameter 65003- operating status 64 bit 

The parameter structure 65003 is a read only structure where in-
formation on the 64 bit parameter values can be found. 
 

PNU 65003 

Significance Encoder Operating Status 64 bit 

Data type Array[n] Integer 64 

Access Read 

Validity range Profile specific 

Explanation The status of encoder operating parameters 
with 64 bit length. 

Table 53 Parameter 65003, Operating status 64 bit 

 
 

Sub index Meaning  

0 Header 

1 Offset value 64 bit 

2 Measuring units per revolution 64 bit  

3 Total measuring range in measuring units 
64 bit 

Table 54 Parameter 65003, Sub index 
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7.14.6 Identification & Maintenance functions 

In addition to the PROFIdrive parameter 964, Device Identifica-
tion, I&M functions are supported by the encoder. The I&M func-
tions can be accessed with record index 0xAFF0-0xAFF4. The fol-
lowing I&M functions are supported. 
 

I&M Parameter Octets Comment 

Header 

Manufacturer specific 10 Not used 

I&M Block 

MANUFACTURER_ID 2 Manufacturer Id 

ORDER_ID 20 Encoder part number 

SERIAL_NUMBER 16 Encoder serial number 

HARDWARE_REVISION 2 Not used 

SOFTWARE_REVISION 4 Software revision 

REVISION_COUNTER 2 Not used 

PROFILE_ID 2 Encoder Profile number 

PROFILE_SPECIFIC_TYPE 2 Type of encoder, 

IM_VERSION 2 Version of the I&M pro-
file 

IM_SUPPORTED 2 Value = 0 means sup-
port of I&M 

Table 55 Identification & Maintenance 
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8 Firmware upgrade 

The encoder supports a firmware upgrade function. The firmware 
upgrade function is developed to offer the possibility to upgrade 
the encoders in the future. 
 
Before the upgrade of the encoder can start, the following tools 
are needed: 
 

• A  running TFTP server   
• A  WEB browser (Internet Explorer, Firefox, Opera etc.) 
 
The encoder itself puts no restrictions on what TFTP server to 
use. The customer can choose to use any TFTP servers. 
 
Firmware upgrade in a PROFINET network. 
• This is when the encoder is connected to a PROFINET net-

work. The encoder will be provided with an IP address from the 
PROFINET IO controller (with DCP).  
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8.1 Firmware upgrade in a PROFINET network 

The following prerequisites have to be fulfilled in order to upgrade 
the encoder in a PROFINET network: 
 
• The encoder should be attached to the network. 
• The encoder must have a valid Device name and a valid IP ad-

dress (assigned with DCP). 
• A TFTP server should be enabled on the LAN where the en-

coder is attached. See chapter 8.4 for an example how to set 
up a TFTP server. 

 
Once the encoder has been assign a valid IP address it should be 
accessible on the network. Enter the encoders IP address in the 
WEB browser to open the Firmware upgrade page. 
 

 

Figure 39 Firmware upgrade startpage 
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When accessing the encoder with the web browser it will display 
a number of parameters. In the firmware upgrade section of the 
page, enter the following information: 
 

• Server IP address - Enter the IP address to the TFTP server on 
the LAN 

• Firmware filename - Enter the full file name of the new firm-
ware file supplied by the TFTP server 

• Date - Enter the current date for the upgrade. This is stored as 
part of the Upgrade History. The format is yyyy-mm-dd. E.g. 
2010-11-15. 

 

 

Figure 40 Firmware upgrade settings 
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The parameters are set by clicking the Submit Values button. After 
clicking the Submit Values button, update the page in the web 
browser. To start the upgrade, click on the Upgrade button.  
 
A confirmation page is displayed where the upgrade has to be 
confirmed before the device starts the actual firmware upgrade 
process. The Continue button needs to be clicked in order to start 
the upgrade sequence. 
 
 

Figure 41 Firmware upgrade confirmation page 
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During upgrade a progress page is displayed. Depending upon the 
choice of web browser, the auto generated progress page will 
take some time to be displayed. However, the progress web page 
should always be displayed when the upgrade is finished. If no er-
rors occur during upgrade the encoder will automatically reboot it-
self and connect to the PROFINET IO-controller with the new 
firmware. 
 
 

Figure 42 Firmware upgrade status page 
 
During the upgrade, both the bus status LED and the device sta-
tus LED will be flashing green. If an error occurs both LEDS will 
be flashing red. 
 
If the upgrade fails check the error code displayed on the progress 
page. The error codes are described in chapter 8.3. 
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8.2 Error handling 

This chapter will list all the possible error codes that can occur dur-
ing an upgrade error. The error code will be visible on the feedback 
webpage. If an error occurs the device will not reboot itself au-
tomatically. Instead it will wait upon user action. This is to allow 
the user to take the next step. E.g. the user might want to check 
some parameters before rebooting or try to run the upgrade pro-
cedure again. 
 
Failed to download firmware file from server 
Error code: -2 
 

The user should verify the IP address and the image filename. If 
any of them is incorrect the user should go back and submit the 
correct parameters at the main html page (index.html). If the pa-
rameters are correct the user should verify that the TFTP server is 
running on the host computer and that the TFTP server settings 
are correct. 
 
Host not responding/No contact with host computer  
Error code: -3 
 

The user should verify that the host computer is connected to the 
encoder. The ping command can be used for this purpose.  If con-
nected, go back to upgrade.html and click Confirm to try and up-
grade again. 
 
Checksum Error/File image error 
Error code: -4 
 

Calculated checksum doesn’t match the one supplied by the im-
age file. The most likely cause for this problem is that there was 
an error when downloading the file to the encoder. Go back to 
upgrade.html and press Confirm and try again. 
 
Flash Erase/Write Error 
Error code: -5 
 

The image might be corrupt. Flash Erase or Write failed. If this er-
ror occurs the device can still start with its failsafe image. It will be 
displayed by the Execution State parameter on the web Page. 
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File Size Error 
Error Code: -6 
 

The firmware file is too big to be written to flash. 
 
Insufficient Memory 
Error Code: -7 
 

There is not enough memory available to store the firmware file 
image. 
 
Invalid Firmware File 
Error Code: -8 
 

Firmware file is not supported for this hardware. 
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8.3  TFTP server installation 

The TFTP server used in this example is a freeware TFTP server 
for Windows NT/XP/Vista platforms and it can be downloaded 
from www.solarwinds.com. 
 
Unzip the installation file and double click on the SolarWinds-
TFTP-Server.exe file to start the installation. Follow the instruc-
tions on the screen to complete the installation.  
 
Create a folder on C:\ named TFTP_Root (if it not already exists). 
Copy or Move the new firmware file used to the C:\TFTP_Root di-
rectory. 
 
Start the SolarWinds TFTP server and click on the File->Configure 
tab to open up the Configure window. 
 
 

Figure 43 SolarWinds TFTP server 
 

  

http://www.solarwinds.com/
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In the Configure window: 
 

• Make sure that the correct network interface is selected in the 
Used NIC selection menu. I.e. it is the network interface which 
is connected to the encoder network. 

• Set up the path to the TFTP root directory. I.e. the TFTP-Root di-
rectory created under C:\. 

• Leave the other parameters with their default values. 
• Click Start to start the TFTP server service in Windows. 
 
 

Figure 44 SolarWinds TFTP server settings 
 
Note: The server will listen to port 69. Verify that there is no 

firewall blocking the port for incoming/outgoing re-
quests. Disable any firewall temporarily if communica-
tion problems occur. 
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9 Encoder replacement using LLDP 

The encoder supports Link Layer Discovery Protocol (LLDP). 
LLDP is essentially a neighbor discovery protocol used by net-
work devices for advertising of their identity, capabilities and inter-
connections. 
 
In a PROFINET network all IO devices are recognized by their de-
vice name. 
Sometimes an IO device needs to be replaced in an automation 
system, and this is when LLDP is useful. Using LLDP, the neigh-
bor relations between the individual IO device and the IO control-
ler are analyzed and stored on the IO controller. If an IO device 
has been replaced, the IO controller will recognize this and will 
redefine the device name.8 

 
Follow the instruction below to exchange an IO device using 
LLDP: 
Select properties of the PN-IO controllers interface module and 
enable Support device replacement without exchangeable medi-
um. 
 

 

Figure 45 LLDP Properties 
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Configure the topology of the system for all connected ports. 
 

 

Figure 46 LLDP Port configuration 
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In the properties window, select the corresponding partner port.  
 

 

Figure 47 LLDP Partner port settings 
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Then select Edit-> PROFINET IO->Topology to open the topology 
editor. 
 

 

Figure 48 Open Topology editor 
 
 

 

Figure 49 Topology editor 
 
Verify that the offline topology matches the online topology. 
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After the above has been verified it is possible to replace any IO 
device if the ports are reconnected in the same way and the new 
device is set to factory reset. 
 
To manually do a factory set of the encoder, follow the steps be-
low: 
 
Select PLC-> Ethernet-> Edit Ethernet Node. 
 
 

Figure 50 Edit Ethernet node 
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Enter the encoder´s MAC-adress and then click on the Reset 
button. The MAC-adress of the encoder is written on the encoder 
label. 
 
 

Figure 51 Factory reset 
 
 
Click yes in the confirmation window to reset the encoder to its 
factory settings. 
 
 

Figure 52 Factory set confirmation 
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10  Encoder state machine 

 

Figure 53 Encoder state machine 
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10.1 Normal operation state 

 
10.1.1 Profile version 4.x 

If using encoder complying with encoder profile v4.1, then bit 10 
Control by PLC in Control word 2 needs to be set before the data 
in Control word is valid. If not set, Control word is not used by the 
encoder firmware. 
 

10.1.2 Profile version 3.x 

If using encoders complying with encoder profile 3.x, the data in 
Control word is always valid and bit 9 Control requested in Status 
word 2 is always cleared. 
 

10.1.3 Profile version 3.x and 4.x 

When using telegram 81-83 and Control word bit 13 Request ab-
solute value cyclically is set, then Status word bit 13 Transmit ab-
solute value cyclically is set. Status word bit 13 is cleared (bit 
13=0) when Control word bit 13 is cleared. Status word bit 13 is 
always cleared, when using telegram 84 due to the fact that no 
absolute value is sent in G1_XIST2. 
 

10.2 Parking state 

This state can be reached from any other state. The position value 
in G1_XIST1, G1_XIST2 and G1_XIST3 are set to zero. Errors are 
cleared and alarms are disabled in parking mode.  
 

10.3 Set/shift home position (Preset) 

The Set/shift home position is initiated when Control word bit 12 
Request set/shift of home position is set. In this case the Status 
word bit 12 Set/shift of home position executed is set to 1. In or-
der to initiate a set/shift home position Class 4 functionality must 
be enabled otherwise there will be an error in G1_XIST2. 
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10.3.1 Preset depending on different telegrams 

When using standard telegram 81-83, the acyclic encoder param-
eter 65000 Preset value 32 bit shall be used to set a preset value 
(<=32 bit) for the encoder. If the acyclic encoder parameter 65002 
Preset value 64 bit is used in this case, an error message will be 
returned. With telegram 81-83 the operating status must be read 
by encoder parameter 65001 Operating status 32 bit. 
 
With telegram 84, the acyclic encoder parameter 65002 Preset 
value 64 bit shall be used to set a preset value (<=64 bit) for the 
encoder. If the acyclic encoder parameter 65000 Preset value 32 
bit is used in this case, an error message will be returned. With 
telegram 84 the operating status must be read by encoder pa-
rameter 65003 Operating status 64 bit. 
 

10.3.2 Absolute preset with negative value 

Preset data sent with acyclic encoder parameter 65000 or 65002 
are signed values. The relative preset mode uses signed preset 
values, but with the absolute preset mode no preset will be made 
if a negative preset value (set with encoder parameter 65000 or 
65002) is used while trying to initiate an absolute preset. 
 

10.4 Error state 

This state is reached when an error has occurred. The encoder 
can enter this state from both the normal operation state and the 
set/shift home position state. If an error occurs, the Status word 
bit 15 Sensor error is set, and the error code is displayed in 
G1_XIST2 instead of the position value.  
 

10.5 Error acknowledgement 

This state is reached when an error has occurred, and Control 
word bit 15 Acknowledging a sensor error has been set. The Sta-
tus word bit 11 Requirement of error acknowledgment detected 
and Status word bit 15 Sensor error are set to 1. 
 

10.6 Start up 

This state is only reached when Control word bit 14 Activate park-
ing sensor are cleared (=0). Once the Control word bit 14 are 
cleared, it takes about 500ms before the Status word bit 14 Park-
ing sensor active are set to zero (=0).The reason for the delay is 
that before the encoder goes to normal operation mode, an initial-
izing of the encoder is made. 
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11  Frequently asked questions FAQ 

 
1. Problem:  

Preset, parking mode and error reset is not possible. 
 
Solution:  
The Control By PLC bit in Control Word 2 has to be set to 1 
(Profile V4.1). 

 
2. Problem:  

The preset value is lost if the power supply is switched off. 
 
Solution:  
Parameter 971 has to be set to 1 in order to save the preset 
value into non volatile memory. 
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	1.1 About absolute encodersWith an absolute encoder each angular position is assigned acoded position value generated by a code disc equipped withseveral parallel fine graduations tracks which are scanned individ-ually.On single turn encoders, i.e. an encoder producing absolutepositions within one revolution, the absolute position informationrepeats itself with every revolution. So called multi turn encoderscan also distinguish between revolutions. The numbers of uniquerevolutions is determined by the resolution of the multi turn scan-ningand repeats itself after the total resolution is reached. A ma-jorbenefit of absolute encoder type is that if the encoder losespower, the encoder is able to keep track of its position also if theshaft is turned during the power loss...
	& PROFINET International (PI) for automation. PROFINET usesTCP/IP and IT standards, and is in effect, real-time Ethernet. ThePROFINET concept features a modular structure so that users canselect the cascading functions themselves. They differ essentiallybecause of the type of data exchange to fulfill the partly very highrequirements of speed.In conjunction with PROFINET, the two perspectives PROFINETCBA and PROFINET IO exist. PROFINET CBA is suitable for thecomponent-based communication via TCP/IP and the real-timecommunication for real-time requirements in modular systemsengineering. Both communication options can be used in parallel.PROFINET IO was developed for real time (RT) and isochronousreal time (IRT) communication with the de-centralized periphery.The design...
	Ł The IO Device, which is a field device such as an encoder, mon-itoredand controlled by an IO Controller.Ł The IO Supervisor is software typically based on a PC for set-tingparameters and diagnosing individual IO Devices.An application relation (AR) is established between an IO Control-lerand an IO Device. These ARs are used to define communica-tionrelations (CR) with different characteristics for the transfer ofparameters, cyclic exchange of data and handling of alarms.The characteristics of an IO Device are described by the devicemanufacturer in a General Station Description (GSD) file. The lan-guageused for this purpose is the GSDML (GSD Markup Lan-guage)- an XML based language. The GSD file provides the su-pervisionsoftware with a basis for planning the configur...
	available from PROFINET for use in specific devices or appli-cationssuch as encoders. They are specified by PI (PROFIBUS &PROFINET International) working groups and published by PI. Pro-filesare important for openness, interoperability and interchange-ability,so that the end user can be sure that similar equipmentsfrom different vendors perform in a standardized way.HEIDENHAIN comply with the definitions in the encoder profile3.162, version 4.1. The encoder device profile describing encoderfunctionality and additional information about PROFINET can beordered from PROFIBUS User Organization, PNO.PROFINET is generally defined by PROFIBUS & PROFINET Inter-national(PI) and backed by the INTERBUS Club and, since 2003,is part of the IEC 61158 and IEC 61784 standards.PROFIB...
	D 76131 Karlsruhe Tel: +49 721 96 58 
	Fax: + 49 721 96 58 
	Web: www.profibus.com
	Order No. 3.
	Profile Drive Technology, PROFIdrive V4.1, PROFIBUS International, Order No. 3.
	PROFIBUS Encoder Profile V1.1, PROFIBUS International, Order No. 3.
	PROFIBUS Guidelines, Part 1: Identification & Maintenance Func-tions V1.1, PROFIBUS International, Order No. 3.
	PROFIBUS Guidelines, Part 3: Diagnosis, Alarms and Time Stamp-ing V1.0, PROFIBUS International, Order No. 3.
	PROFINET Application Layer Service Definition Application LayerProtocol Specification, Version 2.0, PROFIBUS International, Order No. 2.
	PROFIBUS Guidelines: PROFIBUS Interconnection Technology V1.1, PROFIBUS International, Order No. 2.
	PROFINET Guidelines: PROFINET Cabling and InterconnectionTechnology V1.99, PROFIBUS International, Order No. 2.
	IO Input/OutputDO Drive ObjectDU Drive UnitAR Application RelationCR Communication RelationMLS Master Sign-Of-LifeRT Real Time EthernetIRT Isochronous Real Time EthernetIsoM Isochronous ModeLLDP Link Layer Discovery ProtocolGSD General Station DescriptionGSDML General Station Description Markup LanguageUDP User Datagram ProtocolTCP Transmission Control ProtocolIP Internet ProtocolDHCP Dynamic Host Configuration ProtocolTFTP Trivial File Transfer ProtocolMAC Media Access Control I&M Identification & Maintenance
	A summary of the PROFINET guideline: PROFINET Cabling andinterconnection TechnologyV 1.99, PROFIBUS International, Order No 2.252 is provided in thissection.2.1 Cables and standardsTwo shielded copper cables twisted in pairs are defined as thenormal transmission medium for PROFINET networks. In suchnetworks the signal transmission is performed in accordance with100BASE-TX at a transmission speed of 100 Mbps (Fast-Ethernet).Only shielded cables and connecting elements are allowed in aPROFINET network. The individual components have to satisfythe requirements of Category 5 in accordance with IEC 11801. Theentire transmission path has to meet the requirements of Class Din accordance with IEC 11801. Furthermore, PROFINET cablesshall have a cable cross-section of AWG 22 i...
	The M12 connector used is a 4-pin female shieldedD-coded version.The correct arrangement of the bus connectors are specified asfollows: Signal Function Pin Tx+ Transmission data + 
	Tx- Transmission data - 
	Rx+ Receiver data + 
	Rx- Receiver data - 
	Table 1 Bus Connection Figure 
	Bus connectorsNote: The encoder provides integrated switch functionalitybetween the two M12 connectors used for PROFINETcommunication. It is important to distinguish betweenthese ports when IRT-communication is used.The M12 connector used for power supply of the encoder is con-stitutedby a 4-pin male shielded A-coded version.The correct arrangement of the power supply line is specified asfollows: Signal Function Pin +E Volt Power supply 
	Not connected - 
	0 Volt 0 Volt 
	Not connected - 




























	Table 2 Power supply connection Port 2 Port 
	Supply
	high levels of electromagnetic disturbance. Switching large elec-tricalloads creates high interference levels that can be picked upin various ways by electronic devices with detrimental effects.Even under such conditions, electric components within an auto-mationsystem must still guarantee a continuous, uninterruptedfunction.The electromagnetic compatibility (EMC) of the entire plant mustbe ensured by using suitably designed components and assem-blingthem correctly to make up the system. Data cabling is con-sideredas a passive system and cannot be tested for EMC com-plianceindividually. Nevertheless, cabling and connection ele-mentsfor PROFINET supports compliance with devices require-mentsby providing a high-quality, comprehensive shielding con-cept.To achieve the h...
	encoders two bi-colored LEDs.Module Meaning CauseOff No powerGreen No connection to anoth-erdevice.Criteria: No data ex-change - bus disconnected- Master not availble/switched offred Green Parameterization fault,no data exchangeCriteria: Data exchangecorrect, however the en-coderdid not switch tothe data exchange mode - Slave not configuredyet or wrong configu-ration- Wrong station addressassigned- Actual configuration ofthe slave differs fromthe nominal configura-tionRed System failure Diagnosis exists, slave indata exchange modeGreen Data exchange and en-coderfunctions properlygreen Blinking green Firmware upgrade inprocessred Blinking red Failure during firmwareupgradeblinking frequency is 0.5 Hz. Minimal indication time is 3 seconds. 3 Led indication
	This chapter will illustrate how to setup and configure aPROFINET encoder for working in RT Class 1 mode. In the follow-ingexamples SIMOTION SCOUT V.4.1.5.6 and D435 motion con-trolleris used. Please refer to the manufacturer of the configura-tiontool if other configuration tools are being used.3.1 Device description file installation (GSDML)In order to start using an absolute encoder with PROFINET inter-face,a device description file needs to be downloaded and im-portedto the configuration software. The device description file iscalled a Generic Station Description Markup Language file andcontains the necessary implementation parameters needed for aPROFINET IO device.The GSDML file can be downloaded from www.heidenhain.comGSDML fileGSDML-V2.2-JH-PROFINET-Encoder-xxx...
	Figure 3 Installation of GSDML file1. Select Options -> Install GSD File and click the Browse buttonto navigate to the location of the GSD file. If a bitmap picturerepresenting the encoder is requested, make sure that thebitmap file is located in the same folder as the GSDML file. Abitmap file is included in the zip-file downloadable fromwww.heidenhain.com.2. Select the GSD file and click the Installbutton to start installing the selected GSD file.


	When the GSD file has been installed the supported encodertypes can be found in the HW Configuration under PROFINET IO->Additional Field Devices->Encoders->JH Group PROFINET En-coders.Select either multi turn 25 bit or single turn 13 bit encoder,dependent on the type of encoder to be configured. Drag anddrop the encoder onto the PROFINET IO system as shown in thepicture below. In the example below one 25 bit multiturn encoderwas chosen. If more than one encoder shall be configured, thenthe following steps need to be done once for each device. Figure 4 Encoder configuration
	Figure 5 Example of connected encoder
	25 bit encoder can be found under Multiturn 25 Bit -> EOMultiturn. In the example below standard telegram 81 is used.Drag and drop the telegram onto slot 1, sub slot 2 as shown inthe figure 6 below. For more information regarding the differenttelegrams refer to chapter 4.4.Figure 6 Telegram selection The Standard Telegram 81 will appear on slot 1 sub slot 
	according to figure 7 below.
	name. The encoders are delivered without any device namepreset from the factory. To set the encoder device name, doubleclick on the encoder icon to open the Properties window.Figure 8 How to set encoder device nameIn the Properties window, enter an appropriate device name in the Device name field.
	Then select PLC-> Ethernet->Assign Device Name to open theAssign device name window. Figure 10 Assign device name
	is written on the encoder label.Figure 11 Assign nameNote: All connected devices need to be assigned a uniquedevice name.After changing device name, it is recommended to verify that theperformed change has been done. This is done by opening theVerify Device Name window found under PLC->Ethernet->Verify Device Name.
	Figure 13 Verify device name



	encoder.To set the encoder user parameters double click on the ParameterAccess point field located under slot 1.1 as shown in figure 14, toopen the Properties window. 14 Parameter Access point
	parameter. For more information regarding parameter data, seechapter 7.Figure 15 Parameter dataWhen the configuration and parameterization of the device hasbeen done, the settings need to be saved and compiled. This isdone by clicking on the Save and Compile option under the Sta-tiontab. Figure 16 Save and compile
	Figure 17 Download settings






	PROFINET encoder in isochronous operation. In the example be-lowSTEP 7 v5.4 SP5 and SIMOTION D435 motion controller isused. The basic principal for configuration and parameterization ofthe encoder is the same as described in chapter 3.2-3.4.To set the IRT settings of the encoder, double click on the Inter-facefield located under slot 0, sub slot X1 to open the Propertieswindow.Figure 18 Open Interface propertiesUnder the Synchronization tab change the value for the ParameterRT Class to IRT and the IRT option parameter to High Perfor-manceaccording to the picture below. Figure 19 RT Class option
	20 Interface propertiesUnder the IO Cycle tab change the Update Time Mode to fixedfactor. 21 IO Cycle properties
	To set the topology double click on the port from which the en-coder is connected to the network. This is either slot 0 sub slot P


	or slot 0 sub slot P2. In the example in figure 22 below Port 1 isused on the encoder. For port description of the encoder seechapter 2.2 Connectors and pin configuration.Figure 22 Port settingsUnder the Topology tab change the Partner port to the used portof your IO controller. Figure 23 Topology settings
	found under Edit->PROFINET IO.Verify that the RT Class is set to IRT and that the IRT option is setto High performance.Figure 24 Domain management The encoder is now prepared for operating in IRT mode.

	4.1 Encoder profile overview, PNO order no.3.
	This manual is related to encoders that fulfills the demands andfunctionality according to encoder profile V4.1 (PNO no 3.162).The operating functions for encoders according to this profile aredivided into two application classes, named Class 3 and Class 4.For an overview of the different encoder profile for PROFIBUSand PROFINET and the related standards, see figure 25 below.For further information regarding the encoder functionality refer tothe device profile. The profile and PROFINET technical informationcan be ordered at PNO in Karlsruhe, Germany(www.profinet.com). Figure 25 Overview of encoder profiles
	PROFINET IO device according to the encoder profile V.4.1 (PNOno 3.162). A Class 4 configured encoder fully supports all func-tionalityaccording to the encoder profile V4.1.CLASS 3 Encoder with base mode parameter access and limited parame-terizationof the encoder functionality. Isochronous mode is notsupported.CLASS 4 Encoder with scaling, Preset and base mode parameter access.Isochronous mode is supported.Standard signalsTable 5 below describes the standard signals that are used to con-figurethe IO data. The signals are described in the chapters thatfollow.Significance Abbreviation Length(bits) Data typeVelocity value A NIST_A 16 SignedVelocity value B NIST_B 32 SignedControl word G1_STW 16 UnsignedStatus word G1_ZSW 16 UnsignedPosition value 1 G1_XIST1 32 Unsigned...


	telegram structures. The telegrams are used to specify thedata length and which type of data that are sent to and from theIO controller. The following standard telegrams are supported. 4.4.1 Standard Telegram 
	Standard telegram 81 uses 4 bytes for output data from the IOcontroller to the encoder and 12 bytes of input data from the en-coderto the IO-controller.Output data from the IO controller:2 bytes Control word 2 (STW2_ENC).2 bytes Control word (G1_STW). IO Data (word) 1 
	Byte 0 1 2 
	Set point STW2_ENC G1_STW Table 6 Output data Telegram 
	Input data to the IO controller:2 bytes Status word 2(ZSW2_ENC).2 bytes Status word (G1_ZSW).4 bytes Position value 1 (G1_XIST1).4 bytes Position value 2 (G1_XIST2). IO Data (word) 1 2 3 4 5 
	Byte 0 1 2 3 4 5 6 7 8 9 10 
	Actual value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST



	Table 7 Input data Telegram 
	controller to the encoder and 14 bytes of input data from the en-coderto the controller.Output data from the IO controller:2 bytes Control word 2 (STW2_ENC).2 bytes Control word (G1_STW). IO Data (word) 1 
	Byte 0 1 2 
	Set point STW2_EN G1_STW Table 8 Output data Telegram 









	Input data to the IO controller:2 bytes Status word 2(ZSW2_ENC).2 bytes Status word (G1_ZSW).4 bytes Position value 1 (G1_XIST1).4 bytes Position value 2 (G1_XIST2).2 bytes Velocity value A (NIST_A) Data (word) 1 2 3 4 5 6 
	0 1 2 3 4 5 6 7 8 9 10 11 12 
	value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2 NIST_A 9 Input data Telegram 
	to the encoder and 16 bytes of input data from the encoderto the controller.Output data from the IO controller:2 bytes Control word 2 (STW2_ENC).2 bytes Control word (G1_STW). IO Data (word) 1 
	Byte 0 1 2 
	Set point STW2_ENC G1_STW Table 10 Output data Telegram 
	Input data to the IO controller:2 bytes Status word 2(ZSW2_ENC).2 bytes Status word (G1_ZSW).4 bytes Position value 1 (G1_XIST1).4 bytes Position value 2 (G1_XIST2).4 bytes Velocity value B (NIST_B) IO Data (word) 1 2 3 4 5 6 7 
	Byte 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

	Actual value ZSW2_ENC G1_ZSW G1_XIST1 G1_XIST2 NIST_B Table 11 Input data Telegram 
	to the encoder and 20 bytes of input data from the encoderto the controller.Output data from the IO controller:2 bytes Control word 2 (STW2_ENC).2 bytes Control word (G1_STW). IO Data (word) 1 
	Byte 0 1 2 
	Set point STW2_ENC G1_STW Table 12 Output data Telegram 
	Input data to the IO controller:2 bytes Status word 2(ZSW2_ENC).2 bytes Status word (G1_ZSW).8 bytes Position value 3 (G1_XIST3).4 bytes Position value 2 (G1_XIST2).4 bytes Velocity value B (NIST_B)Data 1 2 3 4 5 6 7 8 9 
	0 1 2 3 4 5 6 7 8 9
	10 11 12 13 14 15 16 17 18 
	ZSW






	_ENC G1_ZSW G1_XIST3 G1_XIST2 NIST_B 13 Input data Telegram 
	Note: In standard Telegram 84, G1_XIST2 is used to transfererror codes and optionally position values if the meas-uring length exceeds 64 bits.
	cyclic data transmission and also the possibility to do a preset viaIO-data without the need of control word and status words.The preset function can be used to set the actual position of theencoder to any entered value within the working range of the en-coder.If scaling is active and has been done on the encoder it isonly possible to enter a preset value within the working range ofthe encoder.The preset is activated when the most significant bit (bit 31) is setto 1. The actual preset value should be entered in the followingbits according to below. IO Data (word) 1 
	Byte 0 1 2 

	Bits 31(MSB) 30-24 23-16 15-8 7-0(LSB)Preset control bit Preset value < total resolutionTable 14 Output data from IO-controller to encoderThe manufacturer telegram 59001 input data consist of a 4 bytesposition data value and a 4 byte velocity value as shown below.The velocity value uses the format that is defined in the Velocitymeasuring unit. IO Data (word) 1 2 3 
	Byte 0(MSB) 1 2 3(LSB) 4(MSB) 5 6 7(LSB)Actual value Position value32 bit Unsigned in Velocity value32 bit Signed intTable 15 Input data from encoder to IO-controller Note: User parameter Class 4 functionality and G1_XIST
	Preset control must be activated in order to activate
	value in binary format. By default the G1_XIST1 signal is equalto the G1_XIST2 signal. The format of the actual position values inG1_XIST1 and G1_XIST2 is shown below.Format definition for G1_XIST1 and G1_XIST2:Ł All values are presented in binary formatŁ The shift factor is always zero (right aligned value) for bothG1_XIST1 and G1_XIST2.Ł The setting in the encoder parameter data affects the positionvalue in both G1_XIST1 and G1_XIST2.Ł G1_XIST2 displays the error telegram instead of the positionvalue if error occurs.Example:25 bit multi turn absolute encoder (8192 steps perrevolution, 4096 distinguishable revolutions)M = Multi turn value (Distinguishable revolutions)S = Single turn value (number of steps per revolutions) 26 Absolute value in G1_XIST
	27 Absolute value in G1_XIST
	with a resolution exceeding 32 bits.Format definition for G1_XIST3:Ł Binary formatŁ The actual position value is always right aligned, a shifting factoris not used.Ł The settings in the encoder parameter data affect the positionvalue in G1_XIST3 if Class 4 is enabled. IO Data 1 2 3 
	Format 64 bit position value Table 16 Format of G1_XIST





	of life and it includes the fault buffer handling and Control by PLCmechanism from PROFIdrive STW1 and the Controller Sign-Of-Life mechanism from PROFIdrive STW2. This signal is mandatoryfor controlling the clock synchronization.Bit Function0..6 Reserved7 Fault Acknowledge8,9 Reserved10 Control by PLC11 Reserved12..15 Controller Sign-of-lifeTable 17 Control word 2 (STW2_ENC)Value Significance Comments1 Fault Acknowledge (0->1) The fault signal is acknowledged witha positive edge. The encoder reactionto a fault depends on the type of fault.0 No significance1 Control by PLC Control via interface, EO IO Data isvalid.0 No Control by PLC EO IO Data not valid,except Sign-Of-Life15 Controller Sign-Of-Life 18 Detailed assignment of control word 2 (STW2_ENC)
	of life and it includes the fault buffer handling and Control by PLCmechanism from PROFIdrive ZSW1 and the Slave Sign-Of-Lifemechanism from PROFIdrive ZSW2. This signal is mandatory forcontrolling the clock synchronization.Bit Function0..2 Reserved3 Fault present/No fault4..8 Reserved9 Control requested10,11 Reserved12..15 Encoder Sign-of-lifeTable 19 Status word 2 (ZSW2_ENC)Bit Value Significance Comments3 1 Fault Present Unacknowledged faults or currently notacknowledged faults (fault messages) are pre-sent(in the buffer).The fault reaction is fault-specificand device-specific. The acknowledgingof a fault may only be successful, if the faultcause has disappeared or has been removedbefore. If the fault has been removed the en-coderreturns to operation. The related f...
	Bit Function0..7 Function requests: Reference mark search,measurement on the fly8..10 Reserved (without effect)11 Home position mode position mode (Preset)12 Request set/shift of home position (Preset)13 Request absolute value cyclically14 Activate parking sensor15 Acknowledging a sensor errorTable 21 Control word (G1_STW)Note: If the sensor parking is activated (bit 14 = 1) the encod-eris still on the bus with the slave sign of life active and the encoder error and diagnostics switched off.
	messages of major encoder functions.Bit Function0..7 Function status: Reference mark search, measure-menton the fly8 Probe 1 deflected9 Probe 2 deflected position mode (Preset)10 Reserved, set to zero11 Requirements of error acknowledgment detected12 Set/shift of home position (Preset) executed13 Transmit absolute value cyclically14 Parking sensor active15 Sensor errorTable 22 Status word (G1_ZSW)Note: If bit 13 Transmit absolute value cyclically or bit 15 Sen-sorerror is not set there is no valid value or error codetransferred in G1_XIST2.Note: Bit 13 Transmit absolute value cyclically cannot be setat the same time as bit 15 Sensor error as these bitsare used to indicate either a valid position valuetransmission (bit 13) or the error code transmission (bit 15) in G1_XIST2.
	data with programmable controllers and other devices.The non real time channel based on for example TCP (UDP)/IP isused for parameterization, configuration and acyclic read/writeoperations.The RT or Real Time channel is used for process data transfer andalarms.Real-time data are treated with a higher priority than data sentover the open channel. RT communications overrides the openchannel to handle the data exchange with programmable Control-lers.The third channel, Isochronous Real Time (IRT) is the high perfor-mance,high speed channel used for demanding motion Controlapplications. IRT data are treated with a higher priority than RT da-tasent over the RT channel. Figure 28 Real time Communication
	Real-Time, RT Class 
	Ł Unsynchronized Real time communicationŁ Industrial standard switches can be used.Ł Typical application area: Factory automation Real-Time, RT Class 
	Ł Synchronized and unsynchronized data transmissionŁ Special switches supporting IRT is neededŁ Typical application area: Factory automation Isochronous Real Time, RT Class 
	The isochronous operation mode is used when real-time position-ingwith high performance is required. The basic principal is that allPROFINET devices on the net are clock synchronized with thecontroller using a global control broadcast enabling simultaneousdata accusation from all devices with microsecond accuracy. Thedata exchange cycles for IRT are usually in the range of a fewhundred microseconds up to a few milliseconds. The difference toreal-time communication is essentially the high degree of deter-minism,so that the start of a bus cycle is maintained with highprecision. The synchronization is monitored by sign-of life mes-sages in Control word 2 (STW2_ENC) and Status word 
	(ZSW2_ENC).Ł Clock synchronized data transmissionŁ Special switches supporting IRT is needed Ł IRT is required for example motion control applications












	Diagnostics and AlarmsDiagnostic data is always transferred acyclically using Record Datacommunications over the non real time channel. An IO Supervisormust specifically request the diagnostic or status data from the IOdevice using RDO (Record Data Object) services.Alarm data is transmitted from the IO device to the IO controllervia the RT channel.Alarm is generated by the encoder when failure occurs which ef-fectsthe position value. Alarms can be reset (deleted) when allencoder parameters are within the specified value ranges and theposition value is correct.Channel diagnosticsThe encoder outputs a diagnostic interrupt to the CPU when it de-tectsone of the supported channel diagnostics.channelDiagnostic datarecord Descriptionerror 0x900A The encoder fails to read th...
	bit in the Sensor Status word G1_ZSW (bit 15) and evaluation ofthe error code transmitted in G1_XIST2.Supported diagnostic Error code inG1_XIST2 DescriptionSensor group error 0x0001 The encoder fails to read the correctposition valueMemory error 0x1001 The encoder fails to read stored offsetor preset values from the non volatilememoryCommand not supported 0x0F01 User parameter data assignment erroror command error in commands wordsG1_STW and STW2_ENCMaster´s sign of life fault 0x0F02 The number of permissible failures thecontroller's life sign was exceeded. Table 24 Sensor status word

	Acyclic data exchangeIn addition to the cyclic data exchange, the PROFINET encoder al-sosupports acyclic data exchange. The acyclic data exchange istransferred over the non-real time channel and is used to read outand write status information from and to the IO device. The acyclicdata exchange is conducted in parallel to the cyclic data commu-nication.Example of acyclic data:Ł Reading of diagnosticŁ Reading of I&M functionsŁ Reading of PROFIdrive parametersIdentification and Maintenance (I&M functions)Encoders according to the encoder profile 3.162 also support I&Mfunctionality.The main purpose of the I&M functions is to support the end userif the device is acting faulty or missing some of its functionality.The I&M functions could be seen as an electronic nameplate c...
	can be accessed by the Acyclic Data Exchange service using theBase Mode Parameter access local (Record Data Object 0xB02E).6.3.1 General characteristicsAcyclic parameter can be transmitted 1(single) or up to 39 (multi)in one access. A parameter access can be up to 240 bytes long.6.3.2 Parameter requests and responsesRequest header:Request ID, DO-ID and number of parameters of the access.Parameter address:One address for each parameter, if several parameters are ac-cessed.Parameter value:If the Request ID is 0x02 (change value) the value is set in the re-questand if the Request ID is 0x01 (request value), the value ap-pearsin the reply.6.3.3 Changing the preset valueTable 23 below shows the structure of a change value request. Write of Preset value, parameter 
	Parameter request Request reference 0x
	Request ID 0x02 0x02 .Change value, 0x01.read valueDO-ID (axis) 0x01 Drive Object ID No of parameters 0x
	Attribute 0x10 0x10.Value No of elements 0x
	Parameter number 0xFDE8 Parameter 
	Sub index 0x
	Read of Preset value, parameter 
	Parameter request reference 0x
	ID 0x01 0x
	.read valueID (axis) 0x01 Drive Object IDof parameters 0x01 0x01 Read one parameter 0x10 0x











	.Value of elements 0x
	number 0xFDE8 Parameter 
	index 0x
	26 Reading the preset value (request) Read of Preset value, parameter 
	Parameter responsereference 0x00 mirrored ID 0x01 0x




	.read valueID (axis) 0x01 mirrored of parameters 0x
	0x04 0x04= Data type unsigned 

	of values 0x
	or errors 0x00,0x00,0x00,0x64 Preset value 
	6.4.1 Parameter 922, read only922. unsigned int, presents which telegram is used. Telegram 81,82,83,84 or 59001 is possible.6.4.2 Parameter 925, read/write925. unsigned int, maximum allowed MLS (Master sign-of-life) error. Pa-rameter925 may be used to set a maximum on how many consecutiveSign-of-life failures may occur.6.4.3 Parameter 964, read only964.unsigned int964[0] = Manufacturer Id. This is set during manufacturing of the encoder.964[1] = 0.DU Drive unit type, always set to 0.964[2] = 201.Software version964[3] = 2009.Software year964[4] = 2805. Software day and month964[5] = 1. Number of drive objects (DO)6.4.4 Parameter 965, read only 965.OctetString 
	965[0] =0x3D.Encoder profile number965[1] = 31 or 41 .Encoder profile version, set by customer (us-er_parameters)6.4.5 Parameter 971, read/write971. unsigned int, Stores the local parameter set to a non volatilememory. Preset value is saved when writing value 1 and is set to 0 by theencoder firmware when finished. This means that the preset value hasbeen saved when reading back value 0.6.4.6 Parameter 974, read only974.unsigned int 974[0] = 96.Max array length supported by parameter channel.
	975[0] = Manufacturer Id, Set in the production.975[1] = 7011.DO type975[2] = 201.Software version975[3] = 2009.Software year975[4] = 2805.Software day and month975[5] = 0x0005. PROFIdrive DO type class 5 = encoder interface975[6] = 0x8000. PROFIdrive SUB class 1, Encoder application class 4 sup-ported.975[7] = 0x0001.Drive object Id (DO ID).Parameter 979, read only979.unsigned long979[0] = 0x00005111. Number of index describing encoder, Numbers of de-scribedencoders, Version of parameter structure979[1] = 0x80000000. Sensor typeBit 31 = 1 if configuration and parameterization is OKBit 0 = 0 Rotary encoder, Bit 0 = 1 linear encoder Bit 1 = 0 always set to 
	Bit 2 = 0 .32 bit data, Bit 2 = 1 .64 bit data979[2] = 8192 . Encoder scaled resolution979[3] = 0 .Shift factor for G1_XIST1 always set to 0.979[4] = 0 .Shift factor for G1_XIST2 always set to 0. 979[5] = 1 or 4096 .Singleturn = 1, Multiturn = 
	979[6] = 
	979[7] = 
	979[8] = 
	979[9] = 
	979[10] = 
	980.unsigned int 980[0] = 922 980[9] = 
	980[1] = 925 980[10] = 
	980[2] = 964 980[11] = 
	980[3] = 965 980[12] = 
	980[4] = 971 980[13] = 
	980[5] = 974 980[14] = 
	980[6] = 975 980[15] = 
	980[7] = 979 980[16] = 
	980[8] = 61000 980[17] = 















	6.4.10 Parameter 61000, read/writeName of station61000 .OctetString, 240 octets6.4.11 Parameter 61001, read onlyIP of station61001.unsigned long6.4.12 Parameter 61002, read onlyMAC of station61002.OctetString, 6 octets6.4.13 Parameter 61003, read onlyDefault gateway of station61003. unsigned long6.4.14 Parameter 61004, read onlySubnet mask of station61004. unsigned long6.4.15 Parameter 65000 read/writeUsed with telegram 81-83. 65000. signed long, preset value 32 bit.
	65001. unsigned long65001[0] = 0x000C0101 .Header, Version of parameter structureand numbers of index describing the encoder. 12 index and ver-sion 1.
	65001[1] = Operating status (Bit 4 alarm channel control is alwaysset with profile version 4.x)65001[2] = Alarm65001[3] = Supported alarms65001[4] = Warning65001[5] = Warnings supported65001[6] = 0x00000401. Encoder profile version. Always set tothis value.65001[7] = Operating time65001[8] = Offset value65001[9] = Singleturn value, scaled value65001[10] = Total measuring length, scaled value (Linear = 1)65001[11] = Velocity unitŁ step/10 msŁ step/100 msŁ step/1000 msŁ RPMParameter 65002, read/write Used with telegram 
	65002. signed long long, Preset value 64 bit.Parameter 65003, read only Used with telegram 
	65003. unsigned long long,65003[0] = 0x0000000000040101.Header Version of parameterstructure and numbers of index describing encoder. 4 index and version 1.
	65003[1] = Offset value 64 bit
	65000 (preset value). Experience with S7 programmingand Statement List programming language STL is required.Hardware componentsIO controller SIEMENS S7-F CPU CPU 315F-2PN/DPIO Device PROFINET encoderTable 28 Hardware componentsSoftware components SIMATIC STEP 7 V5.4 + SP
	GSDML file forPROFINET encoder GSDML-V2.2-JH-PROFINET-Encoder-xxxxxxxx.xml Table 29 Software components
	Read record block SFB52 RDREC Instance data blocks DB3 and DB
	Request data block DB
	Response data block DB
	Organization blocks OB1, OB82 and OB
	SFB
	SFB52 is standard S7 block for reading parameters. SFB
	SFB53 is standard S7 block for writing parameters. DB










	DB1 is the request data block. 29 Request data block, DB
	DB

	DB2 is the response data block. 30 Response data block, DB




	Figure 31 Instance data block, DB
	DB
	DB4 is the instance data block of SFB


	Figure 32 Instance data block, DB
	Parameter Declaration Data type DescriptionREQ INPUT BOOL REQ=1 Enables data transferID INPUT DWORD Logical address of the PROFINET IOmodule or sub module (PAP-moduleaddress 2039)INDEX* INPUT INT Record numberMLEN* INPUT INT Maximum length of the record in-formationin bytesVALID OUTPUT BOOL New record has been received andis valid.BUSY OUTPUT BOOL Busy=1 during the read operationERROR OUTPUT BOOL Error=1 read errorSTATUS OUTPUT DWORD Block status or error codeLEN* OUTPUT INT Length of record informationRECORD IN_OUT ANY Target area for the record Table 30 Parameters of SFB
	*)  Negative values are interpreted as 16-bit unsigned integers.
	Declaration Data type DescriptionINPUT BOOL REQ=1 Enables data transferINPUT DWORDLogical address of the PROFINET IOmodule or sub module (PAP-moduleaddress 2039)INPUT INT Record numberINPUT INT Length of the record information inbytesOUTPUT BOOL Data record was transferredOUTPUT BOOL Busy=1 during the write operationOUTPUT BOOL Error=1 write errorOUTPUT DWORD Block status or error codeIN_OUT ANY Data record 31 Parameters of SFB
	values are interpreted as 16-bit unsigned integers.


	Figure 34 Diagnostic address of slot 
	35 Variable table
	1) Enable monitoring by clicking the Monitor variable button.2) Write 02hex to address DB1.DBB 1 by entering B#16#02 in the modify valuecolumn.3) Write the new preset value in hexadecimal to address DB1.DBD 12 by enteringthe value in the modify value column. (Ex.DW#16#000001F4)4) Click the Modify variable button. The status value of DB1.DBB 12 should nowcontain the new value.5) Run the program-right click on M8.4 and click "Modify address to 1" to run theprogram. Then stop the program by right click and click "Modify address to 0".6) The status value of DB2.DBD 6 should now have been changed to the newpreset value.7) Change the value in DB1.DBB 1 to 01hex (B#16#01#) and click modify variable.8) To set the encoder to the new preset value bit 12 in control word must be...
	This chapter describes the functions that have been implementedin PROFINET encoders from HEIDENHAIN. The table belowshows the supported functions in the PROFINET encoder.FunctionCode sequenceClass 4 functionalityG1_XIST1 Preset controlScaling function controlAlarm channel controlCompatibility modePreset valuePreset value 64 bitMeasuring units per revolution/Measuring stepTotal measuring rangeMeasuring units per revolution 64 bitTotal measuring range 64 bitMaximum Master Sign of Life failuresVelocity measuring unitEncoder Profile versionOperating timeOffset value Offset value 64 bit
	The code sequence defines whether the absolute position valueshould increase during clockwise or counter clockwise rotation ofthe encoder shaft seen from flange side. The code sequence is bydefault set to increase the absolute position value when the shaftis turned clockwise (0).Attribute Meaning ValueCW Increasing position values with clockwise rotation (seen from shaft side) 
	CCW Increasing position values with counter clockwise rotation (seen from shaft side) 
	Table 33 Code sequenceNote: The position value will be affected when the code se-quenceis changed during operation. It might be nec-essaryto perform a preset after the code sequence hasbeen changed.7.2 Class 4 functionalityThis parameter enables or disables the measuring task functionsScaling, Preset and Code sequence. If the function is enabled,scaling and Code sequence control affects the position value inG1_XIST1, G1_XIST2 and G1_XIST3. A preset will in this case al-waysaffect G1_XIST2 and G1_XIST3 but if the parameterG1_XIST1 Preset control is disabled the preset will not affect theposition value in G1_XIST1.Attribute Meaning ValueEnable Scaling/preset/code sequence control enabled 
	Disable Scaling/preset/code sequence control disabled 
	actual value.If Class 4 functionality is activated and G1_XIST1 Preset control isdisabled, the position value in G1_XIST1 will not be affected by aPreset.Attribute Meaning Value Enable G1_XIST1 is affected by a preset com-mand 
	Disable Preset does not affect G1_XIST1 
	Table 35 G1_XIST1 Preset controlNote: This parameter is disabled by setting the value to 1. Note: There is no functionality of this parameter if the Class 
	functionality parameter is disabled.Scaling function controlThis parameter enables or disables the Scaling function of the en-coder.Attribute Meaning Value Enable Scaling function is enabled 
	Disable Scaling function is disabled 
	Table 36 Scaling function controlNote: The parameter Class 4 functionality must be enabled to use this parameter.
	channel transferred as Channel Related Diagnosis. This functionali-tyis used to limit the amount of data sent in isochronous mode.If the value is zero (default value) only the communication relatedalarms are sent via the alarm channel. If the value is one (1) alsoencoder profile specific faults and warnings are sent via the alarmchannel.Attribute Meaning Value Enable Profile specific diagnosis is switch on 
	Disable No profile specific diagnosis (default) 
	Table 37 Alarm channel controlNote: This parameter is only supported in compatibility mode.
	to Version 3.1 of the Encoder Profile. See below for anoverview of functions affected when the compatibility mode isenabled.Attribute Meaning Value Enable Compatibility with encoder Profile V3.1 
	Disable No backward compatibility (default) 

















	Table 38 Compatibility modeCompatibility mode ena-bled(=0) Compatibility modedisabled (=1)by PLCENC) Ignored, the control word(G1_STW) and the set pointvalues are always valid.Control requested(ZSW2_ENC) is not sup-portedand is set to 0. Supportedparameter MaximumSign of Life failures Supported Not supported, one Sign ofLife failure tolerated,PROFIdrive P925 is optionalto control the life sign moni-toring.parameter Alarmcontrol Supported Not supported, the applica-tionalarm channel is activeand controlled by aPROFIdrive parameter.Profile Version 31 (V3.1) 41 (V4.1) 39 Compatibility mode overview
	from the encoder to a known mechanical reference point of thesystem. The preset function sets the actual position of the encod-erto zero (= default value) or to the selected preset value. Thepreset function is controlled by bits in the control word (G1_STW)and acknowledged by a bit in the status word (G1_ZSW). A presetvalue can be set more than once and it can be stored to the non-volatilememory using PROFIdrive parameter 971.The preset function has an absolute and a relative operating modeselectable by bit 11 in the Control word (G1_STW). Bit 11 and bit12 in the Control word controls the preset in the following way. Normal operating mode: Bit 12 = 
	In this mode, the encoder will make no change in the output val-ue. Preset mode absolute: Bit 11 =0, Bit 12 = 
	In this mode, the encoder reads the current position value andcalculates an internal offset value from the preset value and thecurrent position value. The position value is then shifted with thecalculated offset value to get a position value equal to the presetvalue. No preset will be made if a negative preset value is usedwhile trying to initiate an absolute preset. Preset mode relative: Bit 11 =1, Bit 12 = 
	In this mode the position value is shifted by the preset value,which could be a negative or a positive value set by encoder pa-rameter65000 or 65002.The steps below should be followed by the IO-controller whenmodifying the Preset value parameters:1. Read the requested Preset value parameter and check if thereturned value meets the application requirements. If not,proceed with the following steps.2. Write the Preset value into the individual parameter.3. Store the value in the non-volatile memory by PROFIdrive pa-rameter971 if the value should be valid also after the next power on sequence.
	Note: There is no preset activated when the preset value iswritten to the encoder. The preset function is controlledby bits in the control and status words (G1_STW andG1_ZSW) and bit in the operating parameters. The pre-set value is used when a preset is requested by bit 
	in the control word (G1_STW).Scaling function parametersThe scaling function converts the encoder's physical absolute po-sitionvalue by means of software in order to change the resolu-tionof the encoder. The scaling parameters will only be activatedif the parameter Class 4 functionality and Scaling function controlare enabled. The permissible value range for the scaling is limitedby the resolution of the encoder. The scaling parameters are se-curelystored in the IO controller and are reloaded into the encod-erat each power-up.Measuring units per revolutionThis parameter sets the single turn resolution of the encoder. Inother words it is the number of different measuring steps duringone revolution of the encoder.Example:For a 13-bit encoder with a single turn resoluti...
	and 213 (8192).Parameter Meaning Data typeMeasuring units The single turn resolution per revolution in measuring steps Unsigned 
	Measuring unitsper revolution64 bit The single turn resolutionin measuring steps for en-coderswith a resolution exceeding 32 bits. Unsigned 
	total measuring range is calculated by multiplying the single turnresolution with the number of distinguishable revolutions.Example: The total measuring range for a 25 bit multi turn encoder with a 
	bit single turn and a 12 bit multi turn resolution is between 2
	and 2
	(33 554 432).The total measuring range is calculated as below:Measuring units per revolution x Total measuring range= 8192 (213) x 4096 (212) = 
	If the total measuring range is higher than 31 bit, telegram 84 andacyclic encoder parameter 65002 and 65003 must be used. Inthis case the 64 bit values are used and the 32 bit values are setto zero (0) by the encoder.The device has two different operating modes, depending on thespecified measuring range. When the device receives a parame-termessage, it checks the scaling parameters if a binary scalingcan be used. If binary scaling can be used, the device selects op-eratingmode A (see following explanation). If not, operating mode B is selected.
	turns). If the desired total measuring range is equal to the speci-fiedsingle turn resolution * 2X (where x<= 12) the encoder oper-atesin endless cyclic operation (0 - max - 0 -max). If the positionvalue increases above the maximum value by rotating the encod-ershaft, the encoder continues from 0.Example of a cyclic scaling: Measuring units per revolution = 1 
	Total measuring range = 32 
	(2













	= number of revolutions 32) 36 Cyclic operation
	in non-cyclic operation. The non-cyclic operation is affected by theparameter G1_XIST1 Preset control as described below.G1_XIST1 Preset control = EnabledIf the position value increases or decreases outside the maximumvalue or below 0 with the parameter G1_XIST1 Preset control en-abled,the device outputs the maximum position value within thescaled total range for both position values G1_XIST1 andG1_XIST2.Example of non-cyclic scaling with G1_XIST1 Preset controlenabled: Measuring units per revolution = 
	Total measuring range = 






	(number of revolutions 50) Figure 37 Non cyclic operation, preset control enabled
	the device will output the maximum position value within thescaled total range for the position value G1_XIST2. The positionvalue G1_XIST1 is not limited to the scaled total range. For theposition value G1_XIST1, the device will continue to output ascaled position value within the encoder's total measuring range(up to 33554432 positions for a 25 bit encoder).Example of non-cyclic scaling with G1_XIST1 Preset controldisabled: Measuring units per revolution = 
	Total measuring range = 
	(number of revolutions 50) 38 Non cyclic operation, preset control disabled
	tool, this needs to be done according to below:Example: Total measuring range in measuring units = 
	236=  68719476736 = 0x 00 00 00 10 00 00 00 
	Take the 4 least significant bytes above and convert to decimal:.0x00 00 00 00 =0 = Total measuring range LSBThen take the 4 most significant bytes above and convert todecimal:.0x00 00 00 10 =16= Total measuring range MSBIn the configuration software enter the decimal values: Total measuring range LSB = 
	Total measuring range MSB = 







	7.9 Maximum Master Sign-of-Life failuresWith this parameter the number of allowed failures of the mas-ter´s sign of life is defined. The default value is one (1).Parameter Meaning ValueMaximum MasterSign-of-Life failures The number of permissiblefailures of the masters life sign. 1
	Table 41 Maximum master Sign of life failuresNote: This parameter is only supported in compatibilitymode. MSB LSB 4 byte=32 bit 4 byte=32 bit
	used to configure the signals NIST_A and NIST_B. Standard tele-gram81 has no velocity information included and the encoderdoes not use the velocity unit information in this case. Telegram82,83,84 and 59001 includes velocity output and needs a declara-tionof the velocity measuring unit.Parameter Meaning ValueVelocity measuringunits Definition of the units forthe encoder velocity outputvalue See belowVelocity measuring units ValueSteps/s  
	Steps/100ms  
	Steps/10ms  
	RPM  
	Table 42 Velocity measuring unitsThe velocity calculations are made with a maximum of 19 bitsresolution. If the resolution is higher than 219, the value used forvelocity calculations is automatically reduced to 219.Example: For a 37 bit multi turn encoder with a 2
	single turn resolution and a 2
	multi turn resolution, the maximum single turn value forvelocity calculations will be 219. For a single turn encoder the max-imumresolution can be up to 31 bit, but the value used for veloci-tycalculations will in this case also be 219.Note: In case of the steps/s unit, an average is made over200 ms and the value is multiplied by 5.Note: If scaling has been set on the device the velocity calcu-lation is based on the scaled position value. Conse-quently
	document implemented in the encoder. This parameter is not af-fectedby the Compatibility mode settings.Bits Meaning0..7 Profile Version, least significant number,(value range: 0-99), decimal coding8..15 Profile Version,most significant number,(value range: 0-99), decimal coding16..31 ReservedTable 43 Encoder profile7.12 Operating time The operating time monitor stores the operating time for the de-vicein operating hours. The operating time is saved every sixminutes in the non-volatile memory in the device. This happens aslong as the device is powered on.If the operating time function is not used the operating time valueis set to the maximum value (0xFFFF FFFF).Parameter Meaning Data typeOperating time The accumulated power on time Unsigned 
	Table 44 Operating time
	position value with the calculated value. The offset value is storedin a non volatile memory and can be read from the encoder at anytime. The data type for the offset value is a 32 bit or 64 bit binaryvalue with sign, whereby the offset value range is equal to themeasuring range of the device.The preset function is used after the scaling function. This meansthat the offset value is indicated according to the scaled resolutionof the device.Parameter Meaning Data typeOffset value The offset value for encod-erswith a measuring range of maximum 32 bits Integer 
	Offset value 64 bit The offset value for encod-erswith a measuring range exceeding 32 bits Integer 
	Table 45 Offset valueNote: The offset value is read only and cannot be modified by a parameter write access.













	functions.7.14.1 PROFIdrive parametersThe encoder profile V4.1 (PNO no. 3.162) has adopted certainstandard PROFIdrive parameter. The following PROFIdrive param-etersare supported:PNU (Prm.no) Significance Data type Read/Write922 Telegram selection Unsigned 16 R925 Number of Controller Sign-of-Lifefailures which may be tolerated. Unsigned 16 R/W964 Device identification Array[n]Unsigned 16 R965 Encoder Profile number Octet string 2 R971 Transfer to non volatile memory Unsigned 16 W974 Base Mode Parameter Accessservice identification Array[n]Unsigned 16 R975 Encoder object identification Array[n]Unsigned 16 R979 Sensor format Array[n]Unsigned 32 R980 List of supported parameters Array[n]Unsigned 16 R Table 46 Supported PROFIdrive parameters
	supported.(Prm.no) Significance Data type Read/WriteName of station Octet String[240] RIP of station Unsigned 32 RMAC of station Octet String[6] RDefault gateway of station Unsigned 32 RSubnet Mask Of Station Unsigned 32 RPreset value Integer 32 R/WOperating status Array [n]Integer 32 RPreset value 64 bit Integer 64 R/WOperating status 64 bit Array [n]Integer 64 R 47 Encoder parameter numbers
	function. The parameter 65002 should be used if the preset valueexceeds 32 bits. PNU 
	Significance Preset value Data type Integer 
	Access Read and writeValidity range Profile specificExplanation The preset value sets the value for the presetfunction. The preset value can be stored inthe non volatile memory by PROFIdrive pa-rameter971 and will be reloaded at each startup if stored.Table 48 Parameter 65000, Preset value PNU 
	Significance Preset value Data type Integer 
	Access Read and writeValidity range Profile specificExplanation The preset value sets the value for the presetfunction. The preset value can be stored inthe non volatile memory by PROFIdrive pa-rameter971 and will be reloaded at each startup if stored. Table 49 Parameter 65002, Preset value 64 bit
	on the Encoder operating status can be found. It is a com-plementto the PROFIdrive parameter 979 described in the Profilefor Drive Technology, PROFIdrive V4.1, Order nr 3.172 availablefrom PROFIBUS and PROFINET International. PNU 
	Significance Encoder Operating Status Data type Array[n] Integer 
	Access ReadValidity range Profile specificExplanation The operating status displays the status ofthe encoder. Table 50 Parameter 65001, Operating status
	0 Header1 Operating status2 Faults3 Supported Faults4 Warnings5 Supported warnings6 Encoder Profile version7 Operating time8 Offset value9 Measuring units per revolution10 Total measuring range in measuring units11 Velocity measuring unit Table 51 Parameter 65001, Sub index
	the table below.Bits Definition0 Code sequence1 Class 4 functionality2 G1_XIST1 Preset control3 Scaling function control4 Alarm channel control5 Compatibility mode6...7 Reserved for the Encoder manufacturer8..31 Reserved for future use Table 52 Parameter 65001, Sub index 
	on the 64 bit parameter values can be found. PNU 
	Significance Encoder Operating Status 64 bit Data type Array[n] Integer 
	Access ReadValidity range Profile specificExplanation The status of encoder operating parameterswith 64 bit length.Table 53 Parameter 65003, Operating status 64 bitSub index Meaning0 Header1 Offset value 64 bit2 Measuring units per revolution 64 bit3 Total measuring range in measuring units64 bit Table 54 Parameter 65003, Sub index
	I&M functions are supported by the encoder. The I&M func-tionscan be accessed with record index 0xAFF0-0xAFF4. The fol-lowingI&M functions are supported.I&M Parameter Octets CommentHeaderManufacturer specific 10 Not usedI&M BlockMANUFACTURER_ID 2 Manufacturer IdORDER_ID 20 Encoder part numberSERIAL_NUMBER 16 Encoder serial numberHARDWARE_REVISION 2 Not usedSOFTWARE_REVISION 4 Software revisionREVISION_COUNTER 2 Not usedPROFILE_ID 2 Encoder Profile numberPROFILE_SPECIFIC_TYPE 2 Type of encoder,IM_VERSION 2 Version of the I&M pro-fileIM_SUPPORTED 2 Value = 0 means sup-portof I&M Table 55 Identification & Maintenance
	The encoder supports a firmware upgrade function. The firmwareupgrade function is developed to offer the possibility to upgradethe encoders in the future.Before the upgrade of the encoder can start, the following toolsare needed:Ł A running TFTP serverŁ A WEB browser (Internet Explorer, Firefox, Opera etc.)The encoder itself puts no restrictions on what TFTP server touse. The customer can choose to use any TFTP servers.Firmware upgrade in a PROFINET network.Ł This is when the encoder is connected to a PROFINET net-work.The encoder will be provided with an IP address from the PROFINET IO controller (with DCP).
	the encoder in a PROFINET network:Ł The encoder should be attached to the network.Ł The encoder must have a valid Device name and a valid IP ad-dress(assigned with DCP).Ł A TFTP server should be enabled on the LAN where the en-coderis attached. See chapter 8.4 for an example how to setup a TFTP server.Once the encoder has been assign a valid IP address it should beaccessible on the network. Enter the encoders IP address in theWEB browser to open the Firmware upgrade page. Figure 39 Firmware upgrade startpage
	Ł Server IP address - Enter the IP address to the TFTP server onthe LANŁ Firmware filename - Enter the full file name of the new firm-warefile supplied by the TFTP serverŁ Date - Enter the current date for the upgrade. This is stored aspart of the Upgrade History. The format is yyyy-mm-dd. E.g.2010-11-15. Figure 40 Firmware upgrade settings
	A confirmation page is displayed where the upgrade has to beconfirmed before the device starts the actual firmware upgradeprocess. The Continue button needs to be clicked in order to startthe upgrade sequence. Figure 41 Firmware upgrade confirmation page
	should always be displayed when the upgrade is finished. If no er-rorsoccur during upgrade the encoder will automatically reboot it-selfand connect to the PROFINET IO-controller with the newfirmware.Figure 42 Firmware upgrade status pageDuring the upgrade, both the bus status LED and the device sta-tusLED will be flashing green. If an error occurs both LEDS willbe flashing red.If the upgrade fails check the error code displayed on the progress page. The error codes are described in chapter 8.3.
	an upgrade error. The error code will be visible on the feedbackwebpage. If an error occurs the device will not reboot itself au-tomatically.Instead it will wait upon user action. This is to allowthe user to take the next step. E.g. the user might want to checksome parameters before rebooting or try to run the upgrade pro-cedureagain.Failed to download firmware file from server Error code: -
	The user should verify the IP address and the image filename. Ifany of them is incorrect the user should go back and submit thecorrect parameters at the main html page (index.html). If the pa-rametersare correct the user should verify that the TFTP server isrunning on the host computer and that the TFTP server settingsare correct.Host not responding/No contact with host computer Error code: -
	The user should verify that the host computer is connected to theencoder. The ping command can be used for this purpose. If con-nected,go back to upgrade.html and click Confirm to try and up-gradeagain.Checksum Error/File image error Error code: -
	Calculated checksum doesn't match the one supplied by the im-agefile. The most likely cause for this problem is that there wasan error when downloading the file to the encoder. Go back toupgrade.html and press Confirm and try again.Flash Erase/Write Error Error code: -
	The image might be corrupt. Flash Erase or Write failed. If this er-roroccurs the device can still start with its failsafe image. It will be displayed by the Execution State parameter on the web Page.
	The firmware file is too big to be written to flash.Insufficient Memory Error Code: -
	There is not enough memory available to store the firmware fileimage.Invalid Firmware File Error Code: -
	Firmware file is not supported for this hardware.



	for Windows NT/XP/Vista platforms and it can be downloadedfrom www.solarwinds.com.Unzip the installation file and double click on the SolarWinds-TFTP-Server.exe file to start the installation. Follow the instruc-tionson the screen to complete the installation.Create a folder on C:\ named TFTP_Root (if it not already exists).Copy or Move the new firmware file used to the C:\TFTP_Root di-rectory.Start the SolarWinds TFTP server and click on the File->Configuretab to open up the Configure window. Figure 43 SolarWinds TFTP server
	Used NIC selection menu. I.e. it is the network interface whichis connected to the encoder network.Ł Set up the path to the TFTP root directory. I.e. the TFTP-Root di-rectorycreated under C:\.Ł Leave the other parameters with their default values.Ł Click Start to start the TFTP server service in Windows.Figure 44 SolarWinds TFTP server settingsNote: The server will listen to port 69. Verify that there is nofirewall blocking the port for incoming/outgoing re-quests.Disable any firewall temporarily if communica-tion problems occur.

	The encoder supports Link Layer Discovery Protocol (LLDP).LLDP is essentially a neighbor discovery protocol used by net-workdevices for advertising of their identity, capabilities and inter-connections.In a PROFINET network all IO devices are recognized by their de-vicename.Sometimes an IO device needs to be replaced in an automationsystem, and this is when LLDP is useful. Using LLDP, the neigh-borrelations between the individual IO device and the IO control-lerare analyzed and stored on the IO controller. If an IO devicehas been replaced, the IO controller will recognize this and will redefine the device name.
	Follow the instruction below to exchange an IO device usingLLDP:Select properties of the PN-IO controllers interface module and enable Support device replacement without exchangeable medi-um.
























	Figure 46 LLDP Port configuration
	47 LLDP Partner port settings

	Figure 48 Open Topology editor
	To manually do a factory set of the encoder, follow the steps be-low:Select PLC-> Ethernet-> Edit Ethernet Node. Figure 50 Edit Ethernet node
	Figure 51 Factory resetClick yes in the confirmation window to reset the encoder to itsfactory settings. Figure 52 Factory set confirmation
	53 Encoder state machine



	10.1.1 Profile version 4.x If using encoder complying with encoder profile v4.1, then bit 
	Control by PLC in Control word 2 needs to be set before the datain Control word is valid. If not set, Control word is not used by theencoder firmware.10.1.2 Profile version 3.xIf using encoders complying with encoder profile 3.x, the data inControl word is always valid and bit 9 Control requested in Statusword 2 is always cleared.10.1.3 Profile version 3.x and 4.xWhen using telegram 81-83 and Control word bit 13 Request ab-solutevalue cyclically is set, then Status word bit 13 Transmit ab-solutevalue cyclically is set. Status word bit 13 is cleared (bit13=0) when Control word bit 13 is cleared. Status word bit 13 isalways cleared, when using telegram 84 due to the fact that noabsolute value is sent in G1_XIST2.10.2 Parking state This state can be reached from any oth...
	Request set/shift of home position is set. In this case the Statusword bit 12 Set/shift of home position executed is set to 1. In or-derto initiate a set/shift home position Class 4 functionality must be enabled otherwise there will be an error in G1_XIST2.
	65000 Preset value 32 bit shall be used to set a preset value (<=32 bit) for the encoder. If the acyclic encoder parameter 
	Preset value 64 bit is used in this case, an error message will bereturned. With telegram 81-83 the operating status must be readby encoder parameter 65001 Operating status 32 bit.With telegram 84, the acyclic encoder parameter 65002 Presetvalue 64 bit shall be used to set a preset value (<=64 bit) for the encoder. If the acyclic encoder parameter 65000 Preset value 
	bit is used in this case, an error message will be returned. Withtelegram 84 the operating status must be read by encoder pa-rameter65003 Operating status 64 bit.Absolute preset with negative value Preset data sent with acyclic encoder parameter 65000 or 
	are signed values. The relative preset mode uses signed presetvalues, but with the absolute preset mode no preset will be madeif a negative preset value (set with encoder parameter 65000 or65002) is used while trying to initiate an absolute preset.Error state This state is reached when an error has occurred. The encodercan enter this state from both the normal operation state and theset/shift home position state. If an error occurs, the Status wordbit 15 Sensor error is set, and the error code is displayed inG1_XIST2 instead of the position value.Error acknowledgementThis state is reached when an error has occurred, and Controlword bit 15 Acknowledging a sensor error has been set. The Sta-tusword bit 11 Requirement of error acknowledgment detectedand Status word bit ...
	1. Problem:Preset, parking mode and error reset is not possible.Solution: The Control By PLC bit in Control Word 2 has to be set to 
	(Profile V4.1).2. Problem:The preset value is lost if the power supply is switched off.Solution:Parameter 971 has to be set to 1 in order to save the preset value into non volatile memory.
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